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Table 3-10: Downloading and linking master-bts-cdma directory files for device loads

Step Action

NOTE

¢ |f the current LMF code needs to be installed on the LMF PC, or if more information on file
management, creating bts directories, or viewing CDF files is needed, refer to the LMF Users
Guide.

¢ Thetypes of files that can be downloaded include code (.hex or .bin extension) and data (.dds
extension) files. Files may be compressed (indicated by a.Z extension).

1 Enter the following UNIX command, from the/ usr/ | nf directory, to create a device load master
directory (if it does not already exist).

mkdir bts-master-cdma

2 Enter the following UNIX command to change to the newly created directory:

cd bts-master-cdma

3 Obtain the 3.5-in. diskette(s) containing the current release of the BTS operating code and/or data
files.

NOTE

File naming conventions for al processor boards and applicable files for each are listed below.
Rename files using the mv UNIX command as required:
Device File Name(s)

e GLI  <version>-gliboot.hex & gli.dds

e BBX <version>-bbxboot.hex & bbx. dds

e BDC <version>-bdchboot. hex & bdc. dds

e MCC <version>-ntchoot. hex. 0501 & ntc. dds. 0501
e CSM <version>-csnboot. hex & csm dds

e TSU tsuboot. hex

4 Insert the first 3.5 inch floppy diskette. Verify disk is loaded with the proper BTS files/versions by
typing the following at the (I nf): prompt:
seedisk <cr>

5 To load the BTS files from the disk into the appropriate directory, enter the following at the (1 nf ) :
prompt:

fromdisk <cr>

6 If files are compressed, use the unconpr ess *. Z command to unpack files. Rename files to match
the naming conventions listed above if required.

7 Repeat Steps 4 and 5 for each diskette that is a part of thisload.

NOTE
All older versions of files (and linksto files) in the bt s- mast er - bt s- <bt s#> subdirectories must
be removed before beginning this procedure.

.. . continued on next page
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Table 3-10: Downloading and linking master-bts-cdma directory files for device loads

Step

Action

Create softlinks to the device load and data load filesin the bt s- mast er - cdma directory using the
following UNIX commands:

In -s /Jusr/lmf/bts-master-cdma/*.hex lusr/imf/bts-<bt s#>/
In -s /usr/lmf/bts-master-cdma/*.hex.* lusr/imf/bts-<bt s#>/
In -s /usr/Imf/bts-master-cdma/*.dds lusr/imf/bts-<bt s#>/

In -s Jusr/Imf/bts-master-cdma/*.dds.* lusr/imf/bts-<bt s#>/

NOTE

You may need to specify specific file names in the command instead of using the * ”wildcard”
character in order to link multiple versions of files in the same subdirectory. Using *.* will link ALL
filesin the directory.
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Create BTS Specific CDF File

Follow the steps outlined in Table 3-11 to create aBTS specific CDF
file, if one cannot be obtained from the OMCR/CBSC. (Thisisan
interim procedure and is subject to change).

Table 3-11: Create BTS Specific CDF File

Step Action

I CAUTION
If you are not familiar with the UNIX vi editor, create a“dummy” CDF file, and practice making
changesto it, prior to altering the “real” one.

NOTE

For more information on file management, creating bts directories, viewing/editing CDF files, refer
to LMF Users Guide.

1 Determine the CDF file, currently loaded on the LMF, is closest to the configuration at the site. Use a
generic CDF file that equips all devices, if possible. If thisis an OMNI site, use an OMNI CDF file,
if SECTOR, use SECTOR CDF file.

2 List the contents of the bt s- <bt s#> directory by entering the Is command at the (| nf ) prompt
followed by a<cr >, to verify the CDF file for the site does not already exist.

3 Enter the following command to copy an existing CDF file on the LMF hard drive to the new BTS
directory.

cp /usr/imf/bts-sr c_<bt s#>.cdf /usr/Imf/bts- dest _<bt s#>.cdf

NOTE
The following step is for LMF software releases version 5 and 6 only.

4 Globally change the BTS ID in the new CDF file using the following UNIX commands:
vi bts-new <bt s#>.cdf
:1,$ s/Idl = ol d_<bt s#>/Id1 = new_<bt s#>
1,8 s/ol d_<bt s#>_/new_<bt s#>_
Include the underscore after the old and new bts # in the above command
:1,$ s/BTS\[ol d_<bt s#>/BTS\[new_<bt s#>
‘wq

NOTE

You should now be able to log into the bts using the new CDF file. If you search for the old BTS #, it
should be gone. You will have to edit the CDF file (using the vi editor) as far as BBX, MCC, etc.
equipage is concerned.

Update BTS Specific CDF File Device Load Version and Site Type
Follow the steps outlined in Table 3-12 to update the existing BTS
specific CDF file NextLoad parameter, to reflect the current device load
version to be downloaded and verify the correct Site Type. (Thisisan
interim procedure and is subject to change).

CAUTION Device load version in the CDF file must match the current
version loaded at the OMCR/CBSC.
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Table 3-12: Update BTS Specific CDF File Device Load Version

Step

Action

I CAUTION
If you are not familiar with the UNIX vi editor, create a“dummy” CDF file, and practice making
changesto it, prior to altering the “real” one.

* IMPORTANT

CDF files obtained from the OMCR/CBSC are modified by DELTA information being appended to
the end of the CDF file. The information in the DELTA fields take precedence over information in the
“core CDF file” For example: If NextLoad="1.2.3.4.5" for BBX 1 was specified in the CDF file, and
there was a DELTA entry specifying NextLoad="*2.3.4.5.6" appended to the CDF file for the same
BBX, 2.3.4.5.6 would be the version used.

There are two ways resolve this. Edit both the DELTA and “core” areas of thefile to reflect the same
version, or make sure the deltainformation is transferred to the main CDF file and delete all DELTA
CDF file entries.

Globally change the device load version number in the new CDF file using the following UNIX
commands:

vi bts-new <bt s#>.cdf
1% sX.X.X.X.XIY.y.y.y. Y

Where: x.x.x.x.x and y.y.y.y.y represent the old and new version number, respectively.

2w

NOTE
You should now be able to download all devices at the BTS with the current device load version.

Verify the Si t eType and SSType entriesin the CDF file (under the BTS subheading) reflect the
following information. See example of applicable fields of CDF file below.
(CDMA only; 1900 MHz example shown):

BTS[#] = {

Sl t ;ell'ype=3,

SSType=16

I8

Valid SiteTypes (SC9600=1, SCI600(Mixed)=2, SC2400=3, SC2400(Mixed)=4, SC600=5)
Valid SSTypes (CDMA800MHz=8, CDMA1900MHz=16, CDMA900MHz=32)

Update Antenna Mapping Files

Earlier release versions may require the ant enna. map fileto be
updated. There are two antenna mapping files. These are
ant enna. map and ant enna. asu.

Follow the steps outlined in Table 3-13 to check the antenna mapping
file and update as needed.
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Table 3-13: Update Antenna Mapping Files

Step Action
I CAUTION
If you are not familiar with the UNIX vi editor, create a“dummy” CDF file, and practice making
changesto it, prior to altering the “real” one.
NOTE
For more information on file management, creating bts directories, viewing/editing CDF files, refer to
the LMF Users Guide.

1 View theant enna. map file (see below) and verify the Xcvrs listed in the CDF file (and that are
equipped in the BTS) are also listed in the ant enna. map file (for both RX and TX tables). Make
surethe ant enna. map file has enough RX and TX antennas listed to cover the number of sectors
indicated by CDF's SiteConf parameter.

Example of Antenna Map File

R --- R --- -- Sec --  ----- Xevrs -----
R 1:M :RXL: 1 :1,4,5,8

R 2:D :RX2: 1 :1,4,5,8

R 3:M :RX3: 2 :2,4,6,8

R 4:D : RX4: 2 :2,4,6,8

R 5:M :RX5: 3 :3,4,7,8

R 6: D :RX6: 3 :3,4,7,8

T --- Tx --- -- SeCc -- ----- Xevrs -----
T 1: 0 :TXL: 1 1,4

T 2:0 :TX2: 2 2,4

T 3:0 :TX3: 3 3,4

T 4:0 :TX4: 1 5,8

T 5:0 :TX5: 2 6,8

T 6:0 :TX6: 3 7,8

2 Verify all RX and TX antennas listed in thefile ant enna. map areaso listed intheant enna. asu

file.
NOTE
The antenna.asu file is required only if the BTS is equipped with RFDS. Be sure that the information
in antenna files matches your actual configuration.
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Operating the LMF

Basic Operation

|NOTE

Theterms“CDMA LMF’ and “WinLMF’ are interchangeable

The CDMA LMF alows the user to work in the two following operating
environments which are accessed using the specified desktop icon:

* Graphical User Interface (GUI) using the WinLMF icon
e Command Line Interface (CLI) using the WinLMF CLI icon

The GUI isthe primary optimization and acceptance testing operating
environment. The CLI environment provides additional capahility to the
user to perform manually controlled acceptance tests and audit the
results of optimization and calibration actions.

Basic operation of the LMF GUI includes the following:

¢ Selecting and deselecting BTS devices

Enabling devices

Disabling devices
Resetting devices
¢ Obtaining device status

¢ Sorting a status report window

For detailed information on performing these and other LMF operations,
refer to the CDMA LMF Operator’s Guide, 68P64114A78.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time. The architectural design is such that
the GUI must be started before the CLI if you want the GUI and CLI to
use the same handler.

When the CL1 is launched after the GUI, the CLI automatically finds and
uses an in-progress login session with a BTS initiated under the GUI.
This alows the use of the GUI and the CL1 in the same BTS login
Session.

If aCLI handler isaready running when the GUI is launched (this
happens if the CLI window is already running when the user starts the
GUI, or if another copy of the GUI is already running when the user
starts the GUI), a dialog window displays the following warning

message:
The CLI handler is already running.

This may cause conflicts with the LMF.
Are you sure that you want to start the application?

Thiswindow also contains yes and no buttons. Selecting yes starts the
application. Selecting no terminates the application.
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CLI Format Conventions

The CLI command can be broken down in the following way:

* Verb

¢ Deviceincluding device identifier parameters

e Switch

¢ Option parameters consisting of:
- Keywords
- Equals sign (=) between the keyword and the parameter value
- Parameter values

Spaces are required between the verb, device, switch, and option

parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx-<bts id>- <bbx_id> rssi channel=6 sector=5

Refer to the LMF CLI Commands (68P09251A59) for a complete
explanation of the CLI commands and their usage.

Logginginto aBTS

NOTE Be sure that the correct bts-#.cdf and cbsc-#.cdf file is used for
the BTS. These should be the CDF files that are provided for the
BTS by the CBSC. Failure to use the correct CDF files can
result in wrong results. Failureto usethe correct CDF filesto
log into a live (traffic carrying) site can shut down the site.

Logging into a BTS establishes a communications link between the BTS
and the CDMA LMF. You may be logged into one or more BTS'sat a
time, but only one LMF may be logged into each BTS.

Before attempting to log into the BTS, confirm the CDMA LMF is
properly connected to the BTS (see Figure 3-4). Follow the procedurein
Table 3-14 to log into aBTS.

Prerequisites

Before attempting to login to a BTS, ensure the following have been
compl eted:

e The LMF is correctly installed and prepared.

¢ A bts-nnn folder with the correct CDF and CBSC file exists.

e The LMF is correctly installed and prepared, and the LMF computer
was connected to the BTS before starting the Windows operating
system and LMF software. If necessary, restart the computer after
connecting it to the BTS (see Table 3-6 and Figure 3-4).

BTS Login from the GUI Environment

Follow the procedures in Table 3-14 to log into a BTS when using the
GUI environment
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Table 3-14: BTS GUI Login Procedure

Step

Action

Start the LMF GUI environment by double clicking on the WinLMF desktop icon (if the LMF's not
running).

NOTE

If awarning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the LMF GUI environment again:

The CLI handl er is already running.
This may cause conflicts with the LM
Are you sure you want to start the application?

Yes No

Click on Login tab (if not displayed).

If no base stations are displayed in the Available Base Stations pick list, double click on the CDMA
icon.

Click on the desired BTS number.

Click on the Network L ogin tab (if not already in the forefront).

Enter correct |P address (normally 128.0.0.2 for afield BTS) if not correctly displayed in the | P
Address box.

NOTE

128.0.0.2 isthe default IP address for MGLI-1 in field BTS units. 128.0.0.1 is the default 1P address
for MGLI-2.

Typein the correct IP Port number (normally 9216) if not correctly displayed in the | P Port box.

Select the Multi-channel Preselector type from the Multi-channel Preselector drop-down list (default
is MPC) to a device corresponding to your BTS configuration if required.

NOTE

When performing RX tests on expansion frames, do not choose EMPC if the test equipment is
connected to the starter frame.

Click on the Use a Tower Top Amplifier, if applicable.

10

Click on Login. (A BTS tab with the BTS is displayed.)

NOTE
* |f you attempt to log into aBTS that is already logged on, al devices will be gray.

* There may be instances where the BTS initiates alog out due to a system error (i.e., adevice
failure).

* |f the MGLI isOOS_ROM (blue), it will have to be downloaded with code before other devices can
be seen.

¢ |f the MGLI is OOS-RAM (yellow), it must be enabled before other installed devices can be seen.

BTS Login from the CLI Environment

Follow the procedures in Table 3-15 to log into a BTS when using the
GUI environment
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Table 3-15: BTS CLI Login Procedure

Step

Action

Double click the WinLMF CL1 desktop icon (if the LMF CLI environment is not already running).

NOTE

If aBTS waslogged into under a GUI session when the CLI environment was started, the CL1 session
will be logged into the same BTS, and step 2 is not required.

At the/w nf prompt, enter the following command:
login bts-<bts#>  host=<host>  port=<port>
where:

host = MGLI card IP address (defaults to address last logged into for thisBTS or 128.0.0.2 if thisis
first login to this BTS).

port = IP port of the TS (defaults to port last logged into for thisBTS or 9216 if thisisfirst login to
this BTS)

Logging Out

Logging out of aBTS is accomplished differently for the GUI and the
CLI operating environments.

NOTE The GUI and CLI environments use the same connection to a
BTS. If aBTSislogged into in both the GUI and the CLI
environments at the same time, logging out of the BTS in either
environment will log out of it for both. When either alogin or
logout is performed in the CLI window, thereis no GUI
indication that the login or logout has occurred.

Logging Out of a BTS from the GUI Environment

Follow the procedure in Table 3-16 to logout of a BTS when using the
GUI environment.

Table 3-16: BTS GUI Logout Procedure

Step

Action

Click on the BT S tab menu bar.

Click the L ogout item in the pulldown menu (a Confirm L ogout pop-up message will appear).

Click on Yes or pressthe Enter key to confirm logout. You are returned to the L ogin tab.

NOTE

If alogout was previously performed on the BTS from a CLI window running at the same time as the
GUI, aLogout Error popup message will appear stating the system should not log out of the BTS.
When this occurs, the GUI must be exited and restarted before it can be used for further operations.

If aLogout Error popup message appears stating that the system could not log out of the Base Station
because the given BTS is not logged in, click OK and proceed to step 5.

Select File > Exit in the window menu bar, click Yesin the Confirm L ogout popup, and click OK in
the L ogout Error popup which appears again.

If further work is to be donein the GUI, restart it.
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Logging Out of a BTS from the CLI Environment

Follow the procedure in Table 3-16 to logout of a BTS when using the
CLI environment.

Table 3-17: BTS CLI Logout Procedure

Step

Action

* IMPORTANT

If the BTS isaso logged into from a GUI running at the same time and further work must be done
with it in the GUI, proceed to step 2.

Logout of a BTS by entering the following command:
logout bts- <bt s#>

A response similar to the following will be displayed:
LMF>

12: 22:58. 028 Conmand Recei ved and Accept ed
Command=l ogout bt s- 33

12: 22:58. 028 Conmand Recei ved and Accept ed

12: 22:58. 028 Conmmand Successful |y Conpl et ed
REASON_CODE="No Reason”

If desired, close the CLI interface by entering the following command:

exit

A response similar to the following will be displayed before the window closes:
Killing background processes....

Establishing an MMI Communication Session

For those procedures that require MMI communications between the
LMF and BTS FRUSs, follow the procedure in Table 3-18 to initiate the
communication session.

Table 3-18: Establishing MMI Communications

Step Action
1 Connect the LMF computer to the equipment as detailed in the applicable procedure that requires
MMI communication session.
2 Start the named HyperTerminal connection for MMI sessions by double clicking on its Windows
desktop shortcut.
NOTE
If a Windows desktop shortcut was not created for the MMI connection, access the connection from
the Windows Start menu by selecting:
Programs>Accessories>Hyperter minal>Hyper Ter minal><Named Hyper Terminal Connection
(e.g., MMI Session).
3 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the LMF computer Enter key until the prompt identified in the applicable procedure is obtained.
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Figure 3-6: CDMA LMF Computer Common MMI Connections
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BTS Download Overview

Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code isloaded in all devices during
manufacture, factory repair, or, for software upgrades, from the CBSC
using the DownL oad Manager (DLM). Device application (RAM) code
and data must be downloaded to each equipped device by the user before
the BTS can be made fully functional for the site where it isinstalled.

ROM Code

Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance or a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code release level in
the device is not compatible with the required release level of the site
operating software and the CBSC can not communicate with the BTS to
perform the download. An example would be a BTS loaded with R16.0
software where a GL| which is factory-loaded with R9.2.x or earlier
ROM code must be installed to replace a malfunctioning GLI.

Before ROM code can be downloaded from the LMF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.
ROM code must be manually selected for download.

NOTE The ROM code fileis not available for GL13s are ROM code
loaded at the factory.
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ROM code can be downloaded to a device that isin any state. After the
download is started, the device being downloaded will change to

OOS _ROM (blue). The device will remain OOS_ROM (blue) when the
download is completed. A compatible revision-level RAM code must
then be downloaded to the device. Compatible code loads for ROM and
RAM must be used for the device type to ensure proper performance.
The compatible device code release levels for the BSS software release
being used are listed in the Version Matrix section of the SC™ CDMA
Release Notes (supplied on the tape or CD-ROM containing the BSS
software).

Procedures to load ROM code are |located in Appendix J.

RAM Code

Before RAM code can be downloaded from the LMF, the correct RAM
code file for each device must exist on the LMF computer. RAM code
can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the LMF file structure. The RAM code file will be selected
automaticaly if thefileisin the <x>:\<Imf home
directory>\cdma\loads\n.n.n.n\code folder (where n.n.n.n is the
download code version number that matches the “ NextLoad” parameter
of the CDF file). The RAM code file in the code folder must have the
correct hardware bin number for the device to be loaded.

RAM code can be downloaded to adevice that isin any state. After the
download is started, the device being loaded will change to OOS_ROM
(blue). When the download is completed successfully, the device will
change to OOS_RAM (yellow).

When code is downloaded to an MGLI or GLI, the LMF automatically
also downloads data and then enables the MGLI. When enabled, the
MGLI will change to INS_ACT (bright green). A redundant GLI will
not be automatically enabled and will remain OOS_RAM (yellow).
When the redundant GLI is manually commanded to enable through the
LMF, it will change state to INS_SBY (olive green).

For non-GLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS_RAM
(yellow).

The devices to be loaded with RAM code and data are:
* Master Group Line Interface (MGLI)
¢ Redundant GLI

¢ Clock Synchronization Module (CSM) (Only if new revision code
must be loaded)

e Multi Channel CDMA (MCC24E, MCC8E, or MCC-1X) cards
¢ Broadband Transceiver (BBX2 or BBX-1X) cards

* RFDS Test Subscriber Interface Card (TSIC) or RFDS-1X RFDS
PROCessor (RPROC) card, if RFDSisinstalled
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NOTE

IMPORTANT: The MGLI must be successfully downloaded
with RAM code and data, and in INS_ACT (bright green) status
before downloading any other device. The RAM code download
process for an MGL I automatically downloads data and then
enables the MGLI.

Verify GLI ROM Code Loads

Devices should not be loaded with a RAM code version which is not
compatible with the ROM code with which they are loaded. Before
downloading RAM code and data to the processor cards, follow the
procedure in Table 3-19 to verify the GLI devices are loaded with the
correct ROM code for the software release used by the BSS.

Prerequisite

Identify the correct GLI ROM code load for the software release being
used on the BSS by referring to the Version Matrix section of the
SC™ CDMA Release Notes (supplied on the tape or CD-ROM
containing the BSS software).

Table 3-19: Verify GLI ROM Code Loads

Step Action
1 If it has not already been done, start a GUI LMF session and log into the BTS ( refer to Table 3-14).
2 Select all GLI devices by clicking on them, and select Device > Status from the BTS menu bar.
3 In the status report window which opens, note the number in the ROM Ver column for each GL13.
4 If the ROM code loaded in the GLIsis not the correct one for the software release being used on the

BSS, log out of the BTS, disconnect the LMF computer, reconnect the span lines as described in
Table 5-6, and have the CBSC download the correct ROM code version to the BTS devices.

When the GLIs have the correct ROM load for the software release being used, be sure the span lines
are disabled as outlined in Table 3-2 and proceed to downloading RAM code and data.

Download RAM Code and Data to MGLI and GLI

Follow the steps outlined in Table 3-20 to download the RAM code and

data to the MGLI and other installed GL 1| devices.

Prerequisites

* Prior to performing these procedures, ensure a code file exists for each
of the devicesto be loaded (refer to Table 3-3).

* The LMF computer is connected to the BTS (refer toTable 3-6), and is
logged in using the GUI environment (refer to Table 3-14).

Table 3-20: Download and Enable MGLI and GLI Devices

Step Action
1 Be sure the LMF will use the correct software release for code and data downloads by performing the
following steps:
la - Click on Util in the BTS menu bar, and select Tools > Update NextL oad > CDMA from the
pull-down menus.
.. . continued on next page
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Table 3-20: Download and Enable MGLI and GLI Devices

Step Action
1b - Click on the BTS to be |oaded.
--  The BTSwill be highlighted.
1c - Click the button next to the correct code version for the software release being used.
-- A black dot will appear in the button circle.
1d - Click Save.
le - Click OK to close each of the advisory boxes which appear.

2 Prepare to download code to the MGLI by clicking on the device.

3 Click Devicein the BTS menu bar, and select Download > Code/Data in the pull-down menus.
- A statusreport is displayed confirming change in the device(s) status.

4 Click OK to close the status window.
- The MGLI will automatically be downloaded with data and enabled.

5 Once the MGLI is enabled, load and enable additional installed GLIs by clicking on the devices and
repeating steps 3 and 4.

6 Click OK to close the status window for the additional GLI| devices.

Download RAM Code and Data to Non-GLI Devices

Downloads to non-GLI devices can be performed individually for each
device or all installed devices can be downloaded with one action. RAM
code and data are downloaded to non-GL 1 devices in separate steps.

NOTE CSM devices are RAM code-loaded at the factory. RAM codeis
downloaded to CSMs only if a newer software version needs to
be loaded.

NOTE When downloading to multiple devices, the download may fail
for some of the devices (atime-out occurs). These devices can
be loaded individually after completing the multiple download.

Follow the stepsin Table 3-21 to download RAM code and data to
non-GL| devices.

Table 3-21: Download RAM Code and Data to Non-GLI| Devices

Step Action

1 Select the target CSM, MCC, and/or BBX device(s) by clicking on them.

Click Devicein the BTS menu bar, and select Download > Code/Data in the pull-down menus.
- A statusreport is displayed that shows the results of the download for each selected device.

3 Click OK to close the status report window when downloading is completed.

NOTE

After aBBX, CSM, or MCC device is successfully loaded with RAM code and has changed to the
OO0S_RAM gtate (yellow), the status LED should be rapidly flashing GREEN.

.. . continued on next page
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Table 3-21: Download RAM Code and Data to Non-GLI| Devices

Step Action

4 To download data, select the target CSM, MCC and/or BBX device(s).

5 Click Devicein the BTS menu bar, and select select Download > Data in the pull-down menus.
- A statusreport is displayed showing the results of the download for each selected device.

6 Click OK to close the status report window when downloading is completed.
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Select CSM Clock Source

A CSM can one of have three different clock sources. The Select CSM
Source function can be used to select the clock source for each of the
three inputs. This function is only used if the clock source for a CSM
needs to be changed. The Clock Source function provides the following
clock source options.

* Local GPS

* Remote GPS

* HSO (only for source 2 & 3)

e HSOX (only for source 2 & 3)
e LFR (only for source2 & 3)

¢ 10 MHz (only for source 2 & 3)
* NONE (only for source2 & 3)

Prerequisites
MGLI=INS _ACT, CSM= O0S RAM or INS ACT

Table 3-22: Select CSM Clock Source

Step Action
1 Select the applicable CSM(s).
2 Click on the Device menu.
3 Click on the CSM/M AWI menu item.
4 Click on the Select Clock Source menu item. A clock source selection window is displayed.
5 Select the applicable clock source in the Clock Reference Source pick lists. Uncheck the related

check box if you do not want the displayed pick list item to be used.

6 Click on the OK button. A status report window is displayed showing the results of the selection

action.

7 Click on the OK button to close the status report window.

Enable CSMs

Each BTS CSM system features two CSM boards per site. In atypical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuitsto GPS signals. These signals are generated by either an
on-board GPS module (RF-GPS) or a remote GPS receiver (R-GPS).
The CSM2 card is required when using the R-GPS. The GPS receiver
(mounted on CSM 1) is used as the primary timing reference and
synchronizes the entire cellular system. CSM 2 provides redundancy (but
does not have a GPS receivey).

The BTS may be equipped with a LORAN-C LFR, HSO, or external 10
MHz Rubidium source which the CSM can use as a secondary timing
reference. The HSOX is used for expansion frames. In all cases, the
CSM monitors and determines what reference to use at a given time.
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NOTE For RF-GPS, verify the CSM configured with the GPS receiver
“daughter board” isinstalled in the frame's CSM 1 slot before
continuing.

Follow the steps outlined in Table 3-23 to enable the CSMsinstalled in
the C-CCP shelves.

Table 3-23: Enable CSMs
Step Action
1 Click on the target CSM.
From the Device pull down, select Enable.

NOTE

If equipped with two CSMs, enable CSM-2 first

A status report is displayed confirming change in the device(s) status.
Click OK to close the status report window.

NOTE
FAIL may be shown in the status table for enable action. If Waiting For Phase Lock is shown in the
Description field, the CSM changes to the Enabled state after phase lock is achieved.

CSM 1 houses the GPS receiver. The enable sequence can take up to one hour (see below).

* IMPORTANT

The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and operated
by the United States Department of Defense (D.O.D.). The D.O.D. periodically alters satellite orbits;
therefore, satellite trgjectories are subject to change. A GPS receiver that is INS contains an “amanac”
that is updated periodically to take these changes into account.

If a GPS receiver has not been updated for a number of weeks, it may take up to an hour for the GPS
receiver “almanac” to be updated.

Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3-D position fix
for a minimum of 45 seconds before the CSM will come in service. (In some cases, the GPS receiver
needs to track only one satellite, depending on accuracy mode set during the data load).

NOTE
If equipped with two CSMs, CSM-1 should be bright green (INS-ACT) and CSM-2 should be dark
green (INS-STY)

If more than an hour has passed, refer to CSM Verification, see Figure 3-7 and Table 3-26 to determine
the cause.
NOTE

After the CSMs have been successfully enabled, observe the PWR/ALM LEDs are steady green
(alternating green/red indicates the card isin an alarm state).

Enable MCCs

This procedure configures the MCC and setsthe “ TX fine adjust”
parameter. The “TX fine adjust” parameter is not atransmit gain setting,
but a timing adjustment that compensates for the processing delay in the
BTS (approximately 3 uS).

Follow the steps outlined in Table 3-24 to enable the MCCs installed in
the C-CCP shelves.
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The MGLI and CSM must be downloaded and enabled, before
downloading and enabling the MCC.

Table 3-24; Enable MCCs

Step

Action

1 Click on the target MCC(s) or from the Select pull down menu choose MCCs.

2 From the Device menu, select Enable

A status report is displayed confirming change in the device(s) status.

3 Click OK to close the status report window.

Clock Synchronization Manager System Time

The primary function of the Clock Synchronization Manager (CSM)
boards (dlots 1 and 2) isto maintain CDMA system time. The CSM in
dlot 1 isthe primary timing source while slot 2 provides redundancy.
The CSM2 card (CSM second generation) is required when using the
remote GPS receiver (R-GPS). R-GPS uses a GPS receiver in the
antenna head that has a digital output to the CSM2 card. CSM2 can have
adaughter card as alocal GPS receiver to support an RF-GPS signal.

The CSM2 switches between the primary and redundant units (slots 1
and 2) upon failure or command. CDMA Clock Distribution Cards
(CCDs) buffer and distribute even-second reference and 19.6608 MHz
clocks. CCD 1ismarried to CSM 1 and CCD 2 ismarried to CSM 2. A
failureon CSM 1 or CCD 1 cause the system to switch to redundant
CSM 2 and CCD 2.

Each CSM2 board features an ovenized, crystal oscillator that provides
19.6608 MHz clock, even second pulse, and 3 MHz referenced to the
selected synchronization source (see Table 3-26):

e GPS: loca/RF-GPS or remote/R-GPS

* LORAN-C Frequency Receiver (LFR) or High Stahility Oscillator
(HSO)

e External reference oscillator sources

Fault management has the capability of switching between the GPS
synchronization source and the LFR/HSO backup source in the event of
a GPS receiver failure on CSM 1. During normal operation, the CSM 1
board selects GPS as the primary source (see Table 3-26). The source
selection can aso be overridden viathe LMF or by the system software.

Synchronization between the primary and redundant CSM CCD pairs, as
well as the LFR or HSO back-up to GPS synchronization, increases
reliability.

LFR/HSO
The CSM handles the overall configuration and status monitoring
functions of the LFR/HSO. In the event of GPS failure, the LFR/HSO is
capable of maintaining synchronization initially established by the GPS
reference signal.
3-40 SC™4812ET Optimization/ATP Manual Software Release R16.1.x.x Aug 2002

PRELIMINARY




68P09255A57-2

System Tests

The LFR requires an active external antennato receive LORAN RF
signals. Timing pulses are derived from this signal, which is
synchronized to Universal Time Coordinates (UTC) and GPStime. The
LFR can maintain system time indefinately after initial GPS lock.

The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs. The HSO istypically installed in those
geographical areas not covered by the LORAN-C system. Since the
HSO is a free-standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock.

Upgrades and Expansions: LFR2/HSO2/HSOX

LFR2/HSO2 (second generation cards) both export atiming signal to the
expansion frames. The associated expansion frames require an
HSO-expansion (HSOX) whether the starter frame has an LFR2 or an
HSO2. The HSOX accepts input from the starter frame and interfaces
with the CSM cards in the expansion frame. LFR and LFR2 use the
same source code in source selection (see Table 3-26). HSO, HSO2, and
HSOX use the same source code in source selection (see Table 3-26).

NOTE

Allow the base site and test equipment to warm up for 60
minutes after any interruption in oscillator power. CSM board
warm-up allows the oscillator oven temperature and oscillator
frequency to stabilize prior to test. Test equipment warm-up
allows the Rubidium standard timebase to stabilize in frequency
before any measurements are made.

CSM Frequency Verification

Test Equipment Setup

The aobjective of this procedure istheinitial verification of the CSM
boards before performing the RF path verification tests. Parts of this
procedure will be repeated for final verification after the overall
optimization has been completed.

(GPS & LFR/HSO Verification)

Follow the steps outlined in Table 3-25 to set up test equipment.

Step

Table 3-25: Test Equipment Setup (GPS & LFR/HSO Verification)

Action

and that CSM-1 is INS.
NOTE

NOTE

la  Forlocal GPS (RF-GPS): Verify a CSM board with a GPS receiver isinstalled in primary CSM slot 1

Thisis verified by checking the board gjectors for kit number SGLN1145 on the board in slot 1.
1b  For Remote GPS (RGPS):Verify a CSM2 board isinstalled in primary slot 1 and that CSM-1 isINS.

Thisis verified by checking the board gjectors for kit number SGLN4132ED or later.

2 Remove CSM-2 (if installed) and connect a seria cable from the LMF COM 1 port (via null modem
board) to the MMI port on CSM-1 (see Figure 3-7).
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Table 3-25: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action
Reinstall CSM-2.
Start an MMI communication session with CSM-1 by using the Windows desktop shortcut icon (see
Table 3-5)
NOTE

The LMF program must be running when a Hyperterminal session is started.
5  When the terminal screen appears press the Enter key until the CSM > prompt appears.

CAUTION Connect GPS antenna to the (GPS) RF connector ONLY. Dam-
age to the GPS antenna and/or receiver can result if the GPS an-
tennais inadvertently connected to any other RF connector.

Figure 3-7: CSM MMI Terminal Connection

REFERENCE
OSCILLATOR

CSM board shown
removed from frame

MMI SERIAL F/
PORT
i

EVEN SECOND
TICK TEST POINT —» )
REFERENCE

GPS RECEIVER
ANTENNA INPUT

T ANTENNA COAX

LED (NOTE 1) — | " ~
N CABLE NULL MODEM
19.6 MHZ TEST ~_ GPS RECEIVER BOARD
POINT REFERENCE —»'5 ) N (TRN9G66A)

N 9-PIN TO 9-PIN
RS-232 CABLE

\\\@& l /@

LMF
NOTEBOOK
~
DB9-TO-DB25
T T ADAPTER
comi RS-232 SERIAL
NOTES: MODEM CABLE
1. One LED on each CSM:
Green = IN-SERVICE ACTIVE
Fast Flashing Green = OOS-RAM
Red = Fault Condition
Flashing Green & Red = Fault
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GPS Initialization/Verification

Follow the steps outlined in Table 3-26 to connect to CSM-1 installed in
the C-CCP shelf, verifying that it is functioning normally.

Table 3-26: GPS Initialization/Verification

Step

Action

To verify that O ock al arms (0000),Dpll is locked and has a reference source, and
GPS sel f test passed messages are displayed within the report, issue the following MMI
command

bstatus

- Observe the following typical response:
CSM Status | NS: ACTI VE Slot A O ock MASTER

d ock Alarns (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Tinme since reset 0:33:11, time since power on: 0:33:11

Enter the following command at the CSM> prompt to display the current status of the Loran and the
GPS receivers.

sources
- Observe the following typical response for systems equipped with LFR:

N Source Name Type TO Good Status Last Phase Target Phase Valid

0 Local GPS Primary 4 YES CGood 0 0 Yes
1 LFR CHA Secondary 4 YES Good -2013177 -2013177 Yes
2 Not Used

Current reference source nunber: 0

- Observe the following typical response for systems equipped with HSO:

Num Source Nane Type TO Good Status Last Phase Target Phase Valid

0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 No N A timed-out* Ti med-out* No

*NOTE “Timed-out” should only be displayed while the HSO is warming up. “Not-Present” or
“Faulty” should not be displayed. If the HSO does not appear as one of the sources, then configure the
HSO as a back-up source by entering the following command at the CSM> prompt:

ss 1 12

After amaximum of 15 minutes, the Rubidium oscillator should reach operational temperature and the
LED on the HSO should now have changed from red to green. After the HSO front panel LED has
changed to green, enter sources <cr> at the CSM> prompt. Verify that the HSO is now avalid
source by confirming that the bold text below matches the response of the “sources’ command.

The HSO should be valid within one (1) minute, assuming the DPLL islocked and the HSO rubidium
oscillator is fully warmed.

Num Source Nane Type TO Good Status Last Phase Target Phase Valid

0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 Yes N A XXXXXXXXXX XXXXXXXXXX Yes

.. . continued on next page
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Table 3-26: GPS Initidlization/Verification

Step

Action

HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If thisis not the case, have the OMCR determine the correct BT S timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

* IMPORTANT
If any of the above mentioned areas fail, verify:

- If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

- If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

- Verify the HSO isFULLY SEATED and LOCKED to prevent any possible board warpage

Verify the following GPS information (underlined text above):
- GPSinformation is usually the O reference source.
- At least one Primary source must indicate “ Status = good” and “Valid = yes’ to bring the site up.

.. . continued on next page
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Table 3-26: GPS Initidlization/Verification

Step Action
5 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.
gstatus
- Observe the following typical response:
24:06: 08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Tine since last valid fix: 0 seconds.
24: 06: 08
24: 06: 08 Recent Change Dat a:
24: 06: 08 Antenna cabl e delay 0 ns.
24:06:08 Initial position: lat 117650000 nsec, |on -350258000 nsec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24: 06: 08
24:06: 08 GPS Recei ver Status:
24:06: 08 Position hold: |at 118245548 nsec, |on -350249750 nsec, height 20270 cm
24:06:08 Current position: |at 118245548 nsec, |on -350249750 nsec, hei ght 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 CQurrent Dilution of Precision (PDOP or HDOP): 0.
24:06:08 Date & Tinme: 1998:01:13:21:36:11
24: 06: 08 GPS Receiver Status Byte: 0x08
24:06: 08 Chan: 0, SVID. 16, Mde: 8, RSSI: 148, Status: 0xa8
24:06: 08 Chan:1, SVID. 29, Mde: 8, RSSI: 132, Status: 0xa8
24:06: 08 Chan:2, SVID:. 18, Mde: 8, RSSI: 121, Status: 0xa8
24:06: 08 Chan:3, SVID 14, Mde: 8, RSSI: 110, Status: 0xa8
24:06: 08 Chan:4, SVID. 25, Mdde: 8, RSSI: 83, Status: 0xa8
24:06: 08 Chan:5, SVID. 3, Mde: 8, RSSI: 49, Status: 0xa8
24:06: 08 Chan: 6, SVID: 19, Mde: 8, RSSI: 115, Status: 0xa8
24:06: 08 Chan:7, SVID. 22, Mde: 8, RSSI: 122, Status: 0xa8
24: 06: 08
24:06: 08 GPS Receiver ldentification:
24:06: 08 COPYRI GHT 1991-1996 MOTOROLA | NC.
24:06: 08 SFTWP/ N # 98- P36830P
24:06: 08 SOFTWARE VER # 8
24:06: 08 SOFTWARE REV # 8
24:06: 08 SOFTWARE DATE 6 AUG 1996
24:06: 08 MODEL # B3121P1115
24:06:08 HDW\R P/ N # _
24:06: 08 SERIAL # SS@217769
24: 06: 08 MANUFACTUR DATE 6B07
24:06: 08 OPTIONS LI ST 1B
24: 06: 08 The receiver has 8 channels and is equi pped with TRAIM
6 Verify the following GPS information (shown above in underlined text):
- Atleast 4 satellites are tracked, and 4 satellites are visible.
- GPS Receiver Control Task State is “tracking satellites’. Do not continue until this occurs!
- Dilution of Precision indication is not more that 30.
Record the current position base site latitude, longitude, height and height reference (height reference
to Mean SeaLevel (MSL) or GPS height (GPS). (GPS=0 MSL =1).
.. . continued on next page
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Table 3-26: GPS Initidlization/Verification

Step

Action

If steps 1 through 6 pass, the GPSis good.

* IMPORTANT
If any of the above mentioned areas fail, verify that:

- If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

- If Initial position accuracy is “surveyed,” position data currently in the CDF file is assumed to be
accurate. GPS will not automatically survey and update its position.

- The GPS antennais not obstructed or misaligned.

- GPS antenna connector center conductor measures approximately +5 Vdc with respect to the
shield.

- Thereis no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

- Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.

debug dpllp

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power) (If warmed-up proceed to step 9)

CSM-DPLL Task Wait. 884 seconds |eft.
DPLL Task Wait. 882 seconds |eft.
DPLL Task Wait. 880 seconds left. ........... etc.

NOTE

Thewarm command can be issued at the MMI port used to force the CSM into warm-up, but the
reference oscillator will be unstable.

Observe the following typical response if the CSM iswarmed up.

117486 of f: -
117486 of f: -
117470 of f: -
117486 of f: -
117470 of f: -
117470 of f: -

TK SRC. 0 SO
TK SRC. 0 SO
TK SRC. 0 SO
TK SRC. 0 SO
TK SRC. 0 SO
TK SRC. 0 SO

S1:-2013175, - 2013175
S1:-2013175, - 2013175
S1:-2013175, - 2013175
S1:-2013175, - 2013175
S1:-2013175, - 2013175
S1:-2013175, - 2013175

ocoo0oo0oo0o
el
PRORPO®
o oo o o o
PR WRWww

10

Verify the following GPS information (underlined text above, from left to right):
- Lower limit offset from tracked source variable is not less than -60 (equates to 3 ps limit).
- Upper limit offset from tracked source variable is not more than +60 (equates to 3 ps limit).
- TK SRC: 0 is selected, where SRC 0 = GPS.

11

Enter the following commands at the CSM> prompt to exit the debug mode display.
debug dpllp
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LORAN-C Initialization/Verification

Table 3-27: LORAN-C Initialization/Verification

Step Action Note

1 At the CSM> prompt, enter Istatus <cr> to verify that the LFR isin tracking
mode. A typical responseis:

CSM> Istatus <cr>
LFR Station Status:

O ock coherence: 512 > This must be greater
5930M 51/60 dB 0 S/ N Flag: than 100 before LFR
5930X 52/64 dn -1 S/ N FI ag: becomes a valid source.

5990 47/55 dB-6 S/N Flag:
7980M 62/66 dB 10 S/ N Flag:

-l

7980W 65/69 dB 14 S/N Flag: . PLL Station . > Thisshowsthe LFRis
7980X 48/54 dB-4 S/ N Flag: locked to the selected
7980Y 46/58 dB-8 S/N Flag:E PLL station.

7980z 60/67 dB 8 S/N Flag:
8290M 50/65 dB 0 S/ N Flag:
8290W 73/79 dB 20 S/ N Flag:
8290W 58/61 dB 6 S/ N Flag:
8970M 89/95 dB29 S/ N Flag:
8970W 62/66 dB 10 S/ N Flag:
8970X 73/79 dB22 S/N Flag:
8970Y 73/79 dB19 S/ N Flag:
8970z 62/65 dB 10 S/ N Flag:
9610M 62/65 dB 10 S/ N Flag:
9610V 58/61 dB 8 S/ N Flag:
9610W 47/49 dB-4 S/ N Flag:
9610X 46/57 dB-5 S/ N Flag:
9610Y 48/54 dB-5 S/ N Flag:
9610Z 65/69 dB 12 S/ N Flag:
9940M 50/53 dB-1 S/ N Flag:
9940W 49/56 dB-4 S/ N Flag:
9940Y 46/50 dB-10 S/ N Fl ag:
9960M 73/79 dB22 S/ N Flag:
9960W 51/60 dB 0 S/ N Flag:
9960X 51/63 dB-1 S/ N Flag:
9960Y 59/67 dB 8 S/N Flag:
9960Z 89/96 dB 29 S/ N Flag:

mmw mmm

This search list and PLL
LFR Task State: Ifr locked to station 7980W data must match the

LFR Recent Change Dat a: configuration for the

E)Ezzrgl !_I 3;503\?30 5990 7980 8290 8970 9940 9610 9960— > geographical location

LFR Master, reset not needed, not the reference source. of the cell site.
CSv>

.. . continued on next page
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Table 3-27: LORAN-C Initialization/Verification

Step

Action Note

Verify the following LFR information (highlighted above in boldface type):

Locate the “dot” that indicates the current phase locked station assignment (assigned by MM).

Verify that the station call letters are as specified in site documentation aswell asM X Y Z
assignment.

Verify the SIN ratio of the phase locked station is greater than 8.

At the CSM> prompt, enter sources <cr> to display the current status of the the LORAN receiver.

Observe the following typical response.

Num Source Nane Type TO Good Status Last Phase Target Phase Valid
0 Local GPS Primary 4 Yes Good -3 0 Yes
1 LFR ch A Secondary 4 Yes CGood -2013177 -2013177 Yes
2 Not used

Current reference source nunber: 1

LORAN LFR information (highlighted above in boldface type) is usualy the #1 reference source
(verified from left to right).

* IMPORTANT
If any of the above mentioned areas fail, verify:

The LFR antenna is not obstructed or misaligned.

The antenna pre-amplifier power and calibration twisted pair connections are intact and < 91.4 m
(300 ft) in length.

A dependable connection to suitable Earth Ground isin place.
The search list and PLL station for cellsite location are correctly configured .

NOTE
LFR functionality should be verified using the “source” command (as shown in Step 3). Use the

underlined responses on the LFR row to validate correct LFR operation.

Close the hyperterminal window.
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Calibration and Test Equipment

Connecting Test Equipment to the BTS

The following test equipment is required to perform calibration and ATP
tests:

* LMF
¢ Communications system analyzer model supported by the LMF

* Power meter model supported by the LMF (required when using the
HP 8921A/600 and Advantest R3465 analyzers)

* Non-radiating transmit line termination load

¢ Directional coupler and in-line attenuator
* RF cables and adapters
Refer to Table 3-28 and Table 3-29 for an overview of connections for

test equipment currently supported by the LMF. In addition, see the
following figures:

¢ Figure 3-8 and Figure 3-9 show cable calibration test setup.

¢ Figure 3-10, Figure 3-11 and Figure 3-13 show the test set
connections for TX calibration.

* Figure 3-13 and Figure 3-14 show test set connections for 1S-95 A/B
optimization/ATP tests

¢ Figure 3-15 through Figure 3-18 shows test set connections for
IS-95 A/B/C optimization/ATP tests.

¢ Figure 3-19 and Figure 3-20 show typical TX and RX ATP setup with
adirectional coupler (shown with and without RFDS).

Test Equipment GPIB Address Settings

All test equipment is controlled by the LMF through an |IEEE-488/GPIB
bus. To communicate on the bus, each piece of test equipment must have
a GPIB address set which the LMF will recognize. The standard address
settings used by the LMF for the various types of test equipment items
are asfollows:

* Signal generator address: 1
* Power meter address: 13
e Communications system analyzer: 18

Using the procedures included in the Setting GPIB Addresses section of
Appendix D-1, verify and, if necessary, change the GPIB address of each
piece of test equipment used to match the above

Supported Test Sets

CAUTION To prevent damage to the test equipment, all TX test connections
must be through the directional coupler and in-line attenuator as
shown in the test setup illustrations.
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IS-95 A/B Testing

Optimization and ATP testing for IS-95A/B sites or carriers may be
performed using one of the following test equipment:

¢ CyberTest

¢ Advantest R3267 spectrum analyzer with R3562 signal generator and
HP-437B or Gigatronics Power Meter

¢ Agilent E4406A transmitter test set with E4432B signal generator

¢ Agilent 8935 series E6380A communications test set (formerly HP
8935)

¢ Hewlett-Packard HP 8921 (with CDMA interface for 1.9 GHz PCS
Interface) and HP-437B or Gigatronics Power Meter

¢ Spectrum Analyzer (HP8594E) - optional
* Rubidium Standard Timebase - optional

CDMA2000 1X Operation

Optimization and ATP testing for CDMA2000 1X sites or carriers may
be performed using the following test equipment:

¢ Advantest R3267 spectrum analyzer with R3562 signal generator
¢ Agilent E4406A transmitter test set with E4432B signal generator

¢ Agilent 8935 series E6380A communications test set (formerly HP
8935) with option 200 or R2K and with E4432B signal generator for
1X FER

NOTE E4432B signal generator for 1X FER needs to have the options
UNS8,1E5, and 201.

Test Equipment Preparation

See Appendix F for specific steps to prepare each type of test set and
power meter to perform calibration and ATP .
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Test Equipment Connection Charts

To use the following charts to identify necessary test equipment
connections, locate the communications system analyzer being used in
the COMMUNICATIONS SYSTEM ANALYZER columns, and read down
the column. Where a dot appears in the column, connect one end of the
test cable to that connector. Follow the horizontal line to locate the end
connection(s), reading up the column to identify the appropriate
equipment and/or BTS connector.

IS-95A/B-only Test Equipment Connections

Table 3-28 depicts the interconnection requirements for currently
available test equipment supporting IS 95A/B only which meets
Motorola standards and is supported by the LMF.

Table 3-28: 1S-95A/B-only Test Equipment Interconnection
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT
Attenuator
&
Advantest HP 8921 Power GPIB Directional
S GNAL Cyber-Test R3465 HP 8921A W/PCS Meter Interface | LMF Coupler BTS
| | | | | |
| | EVEN ‘ EVEN | | |
EVEN SECOND EVEN EVEN SEC SECOND SECOND SYNC
SYNCHRONIZATION SECREF | SYNCIN | SYNCIN |  SYNCIN | | | MONITOR
P | | | | | | PY
\ PY | | | | | ®
| | e | | | ,
| | T e | | o
\ \ | \ \ \
|  coma |  coma | coma \ | |
19.6608 MHZ TIME ‘ TIME BASE ‘ TIME BASE TIME BASE | | | FREQ
CLOCK BASEIN | \ N MONITOR
I \ | I I \
@ i \ 1 \ \ \ ®
| ® i \ i i i ®
| | ® \ 1 1 1 ®
| | | ® 1 1 1 1)
\ \ | \ \ \
CONTROL IEEE | | | | | SERIAL |
IEEE 488 BUS 488 | GPIB | HP-1B | HP-1B HP-IB | GPIB | PORT |
PY | | | | P | o |
 e— | oo 1o |
et
| | } ¢ T 1
TX TEST RF \ INPUT \ RF \ RF [ \ | 2008 BTS
CABLES INJOUT | 500 | INOUT | INOUT | | | ATTEN. PORT | TX1-6
o | | | | | °
\ PY | | | | | o ——o—1—e
|  e— | | . _o—o—o
| | e | —
RX TEST RF I rroutr | bpuplex |  RFOUT ‘ ‘ ‘
CABLES GEN OUT ‘ 50Q ‘ ouT ‘ ONLY ‘ ‘ ‘ RX1-6
- | | | | 1 -
| ° | | | | °
| | | | |
| @ | | | ®
\ | \ ¢ l l | ®
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CDMA2000 1X/IS-95A/B-capable Test Equipment
Connections

Table 3-29 depicts the interconnection requirements for currently
available test equipment supporting both CDMA 2000 1X and
IS-95A/B which meets Motorola standards and is supported by the

LMF
Table 3-29: CDMA2000 1X/IS-95A/B Test Equipment Interconnection
COMMUNICATIONS SYSTEM
ANALYZER ADDITIONAL TEST EQUIPMENT
Agilent
8935 Agilent | Advantest Attenuator
(Option E4432 R3562 &
200 or | Advantest | Agilent | Signal Signal Power GPIB Directional
S GNAL R2K) R3267 E4406A | Gen. Generator | Meter | Interface | LMF Coupler BTS
- \ \ \ \ \ \ \
EVEN SECOND | SECOND ‘ ‘ TRIGGER PATTERN ‘ EXT TRIG ‘ ‘ ‘ ‘ SYNC
SYNCHRONIZATION | SYNCIN | EXTTRIG | IN TRIGIN | | | | | MONITOR
P | | o— | | | | ®
| @ : o : : : : 0
| | e o | | — o
| | | | | -
19.6608 MHZ | EXT REF | | EXTREF | MODTIME | | | | FREQ
CLOCK IN | | IN | BASEIN | | | | MONITOR
\ \ \ \ \ \ \
— i i i i i i ®
\ | @ 1 1 1 1 1 ®
\ \ | @ \ \ \ \ et
CONTROL ‘ ‘ ‘ ‘ ‘ I'seriaL |
IEEE 488 BUS HP-1B | GP-B | cPB GPIB | GP-IB | HP-IB | GPIB | PORT |
\ \ \ \ \ \ \
7 | T | 1 |
| @ 1 —® & ——e |
\ | @ — —o— *—o |
| | | | | | |
T T T T T T T
10MHZ | 10MHZ  |10MHZOUT| 10MHZ | SYNTHE | | | |
10MHZ | REFOUT | ouT |(SWITCHED) N REFIN | ‘ ‘
T T T T T T T
— 1 ® | \ \ \ \
| @ i —e \ \ \ \
\ | &—T*e® | \ \ \ \
\ \ \ \ \ \ \
SIGNAL SOURCE
CONTROLLED | SERAL | | SERAL | | | |
SERIAL I/O i i i i i i i
| @ | —eo \ \ \ \
\ \ \ \ \ \ \
TX TEST RF | INPUT | RF INPUT | | | | | 20DB  BTS
CABLES noutr | soe | Tsoa | | | \ | ATTEN. PORT | Tx1-6
\ \ \ \ \ \ \
*— ! ! ! ! ! &~
| @ : : : : : |—o-—eo—1—o
B e e e e e e e
RX TEST DUPLEX ‘ ‘ RF OUTPUT‘ RF OUT ‘ ‘ ‘ ‘
CABLES OUT * ‘ ‘ 50 Q ‘ 50 Q ‘ ‘ ‘ ‘ RX1-6
— | | — .
| | * | | | | ¢
\ \ \ ® 1 1 1 1 ®
| | | | | | |
* WHEN USED ALONE, THE AGILENT 8935 WITH OPTION 200 OR R2K SUPPORTS IS-95A/B RX TESTING BUT NOT 1X RX TESTING.
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Equipment Warm-up

NOTE Warm-up BTS equipment for a minimum of 60 minutes prior to
performing the BTS optimization procedure. This assures BTS
stability and contributes to optimization accuracy.

- Time spent running initial or normal power-up,
hardware/firmware audit, and BTS download counts as
warm-up time.

WARNING Before installing any test equipment directly to any BTSTX
OUT connector, verify there are no CDMA channels keyed.
- At active sites, have the OMC-R/CBSC place the antenna
(sector) assigned to the BBX under test OOS. Failure to do
so can result in serious personal injury and/or egquipment
damage.

Automatic Cable Calibration Set-up

Figure 3-8 and Figure 3-9 show the cable calibration setup for the test
sets supported by the LMF. The |eft side of the diagram depicts the
location of the input and output connectors of each test equipment item,
and the right side details the connections for each test. Table 3-33
provides a procedure for performing automatic cable calibration.

Manual Cable Calibration

If manual cable calibration is required, refer to the proceduresin
Appendix Figure 3-8.
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Figure 3-8: Cable Calibration Test Setup - CyberTest, Agilent 8935, Advantest R3465, and HP 8921A

SUPPORTED TEST SETS

Motorola CyberTest

y4 N
Mee=all]] [ = U

ANT IN

RF GEN OUT

Note: The 30 dB directional coupler is not used
with the Cybertest test set. The TX cable is
connected directly to the Cybertest test set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest test
set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

Agilent 8935 Series E6380A
(formerly HP 8935)

o= -
| @.6 = | [g|_
[}
‘ 5
[}
[}
L o
ffffff W _* our
Advantest Model R3465
: ] ©® © © ©) RF OUT 50Q
INPUT 50Q

Hewlett Packard Model HP 8921A

"°

CALIBRATION SET UP

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP FOR TRDC

N-N FEMALE
ADAPTER

C. TXTEST SETUP AND DRDC RX TEST SETUP

50 Q

TERM. DIRECTIONAL

COUPLER
(30 DB)

Lnire

100-W ATT (MIN)
NON-RADIATING
RF LOAD

20 DB IN-LINE
ATTENUATOR

N-N FEMALE

SHORT ADAPTER

CABLE

TX CABLE FOR

I
| I
® o
{ °° ] TX TEST CABLE | TEST |
CALIBRATION SET |
DUPLEX ANT |
ouT IN RX CABLE FOR |
DRDC RX TEST | |
Note: For 800 MHZ only. The HP8921A cannot CABLE CALIBRATION |
be used to calibrate cables for PCS frequencies. [
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Figure 3-9: Cable Calibration Test Setup - Agilent E4406A/E4432B and Advantest R3267/R3562

SUPPORTED TEST SETS

Agilent E4432B (Top) and E4406A (Bottom)

oy O [Ooood|®
=l [ E—— FO| © [@ooo
G |FEE=SEsET] O - O \|®
—J >
® = 00 oo
— =0 000
Eo oo o &
s E0o|0®0 000
e o8 O O O g [=] ©EE 000 )
L \/ — L L. RFOUTPUT
G ) [ (s 50 Q
OO, OO
@ % oo =]
A ED@ (|
= l=)
FOJ
S 000 ®
® 00D
=] DOoD
MEeD00D0 0 o
O : :
RF INPUT
50 Q
NOTE:
10 MHZ IN ON REAR OF SIGNAL GENERATOR IS CONNECTED TO
10 MHZ OUT (SWITCHED) ON REAR OF TRANSMITTER TESTER
(FIGURE F-5).
Advantest R3267 (Top) and R3562 (Bottom)
 E— R —
o o |
=] OO OO0 gZ=
e =
zz,g oooood
TOo DoooOo
TOoDoooo
)
ro 2200
o s o o
INPUT 50 Q
0o000oeee O e
o
[e]
o
[e]
o ® » RF OUT
( | b

NOTE:
SYNTHE REF IN ON REAR OF SIGNAL GENERATOR IS

CONNECTED TO 10 MHZ OUT ON REAR OF SPECTRUM
ANALYZER

Set-up for TX Calibration

CALIBRATION SET UP

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP FOR TRDC

N-N FEMALE
ADAPTER

D. TX TEST SETUP AND DRDC RX TEST SETUP

50 Q
TERM. DIRECTIONAL
COUPLER
l;l (30 DB)
B

20 DB IN-LINE
100-WATT (MIN) ATTENUATOR
NON-RADIATING

RF LOAD

N-N FEMALE
ADAPTER

SHORT
CABLE

TX CABLE FOR
TX TEST CABLE
CALIBRATION

RX CABLE FOR
DRDC RX TEST
CABLE CALIBRATION

Figure 3-10 and Figure 3-11 show the test set connections for TX

calibration.
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Figure 3-10: TX Calibration Test Setup - CyberTest (1S-95A/B) and
Agilent 8935 (1S-95A/B and CDMA2000 1X)

TEST SETS TRANSMIT (TX) SET UP

ﬁ ——4 POWER — | POWER
SENSOR |

TERM (30 DB)

‘ NOTE: IF BTS IS EQUIPPED (OPN'Il'IlzgﬁﬁL)* l
WITH DRDCS (DUPLEXED (OFTORALT
\ | RX/TXSIGNALS), CONNECT l‘—————————l
‘ THE TX TEST CABLE TO COMMUNICATIONS
THE DRDC ANTENNA TEST SET I
‘ CONNECTOR. I
CoMUNICATIONS —— — |
— SVETEMANAL e 100-W ATT (MIN.) I
©.0.0 0| Sl ool | RE NoUT
| RF LOAD >
| GPIB
RE ‘ TX TEST L—————————
IN/OUT *
A POWER METER CAN BE USED IN
CABLE
FRONT PANEL ‘ PLACE OF THE COMMUNICATIONS
‘ C ) TEST SET FOR TX CALIBRATION/
‘ % AUDIT
NOTE: THE 30 DB DIRECTIONAL COUPLER IS NOT USED WITH THE ‘ | DIRECTIONAL
CYBERTEST TEST SET. THE TX CABLE IS CONNECTED DIRECTLY 50 Q J COUPLER
TO THE CYBERTEST TEST SET. ‘ <

77777777777777777777 ﬁ
‘ 20 DB IN-LINE
Agilent 8935 Series E6380A (formerly HP 8935) | ATTENUATOR
HP-IB ‘ TX TEST
TO GPIB | CABLE
BOX
lr—t e ——— i ——
— — Il RX T |
||| ANTENNA ANTENNA |
|| || I CONNECTOR ~ CONNECTOR |
GPIB
‘ ‘ E 1] TRDC | CABLE
] 1 |
1 — | [RX. RX ™  TX
| [8Ts  ANT BTS ANT ||
[] lcPLD CPLD CPLD CPLO|
— — T | ] O * BLACK RECTANGLES
| | REPRESENT THE RAISED
1 | PART OF SWITCHES
RF INJOUT I INTERNAL INTERNAL |
T o
77777777777777777777 I CABLE CABLE I [ DIP SWITCH SETTINGS -0 S
I | | DATA FORMAT | |
BAUD RATE
N TO TOLPA | \\\HH ‘
| | MPC nggs:l\lEG | | ON - mm [m |
I | YT T
Il BTS | ‘L GPIB ADRS G MODE,
I FREQ | "Rs232-GPIB
I MONITOR | INTERFACE BOX
H SYNC | RS232 NULL
1 MONITOR | MODEM
1 LAN | CABLE
‘ I B CSM I
et
LAN
} | 10BASET/ ! CDMA
‘ | 10BASE2 I LMF
| CONVERTER |
[ R, 4
‘ 1| INTERNAL PCMCIA
| UNIVERSAL TWISTED PAIR (UTP) ETHERNET CARD
CABLE (RJ45 CONNECTORS)
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Figure 3-11: TX Calibration Test Setup - Using Power Meter

. _Testsets TRANSMIT (TX) SETUP
T
NOTE: THE HP8921A AND ADVANTEST } POWER I —————— _i
R3465 CANNOT BE USED FOR TX SENSOR POWER METER
NOTE: IF BTS IS EQUIPPED | e
CALIBRATION. A POWER METER MUST BE ‘ WITH DRDCS (DUP?EXED !_ ______
USED. \ RX/TX SIGNALS), CONNECT
THE TX TEST CABLE TO
| THE DRDC ANTENNA
\ CONNECTOR.
\
| 100-W ATT (MIN.)
| NON-RADIATING .
‘ RF LOAD
| TX TEST 3
\ CABLE
‘ == B
\
\ ‘ DIRECTIONAL
COUPLER
| 08 T=r | Gt
\
| I
| 20 DB IN-LINE
| ATTENUATOR
\ TX TEST
\ CABLE
| et ———
‘ | RX X |
\ || ANTENNA ANTENNA |
| | CONNECTOR ~ CONNECTOR |
GPIB
\ | TRDC | CABLE
} | RX  RX ™ X I
| [BTs  anT BTS ANT ||
| | [cPLD cPLD CPLD CPLO|
‘ O O O O * BLACK RECTANGLES
| | REPRESENT THE RAISED
\ | NTERNAL wrernal | PART OF SWITCHES
\ RX T o
| : CABLE X eLE : [ DIP SWITCH SETTINGS -
| | | DATA FORMAT | |
| BAUD RATE ‘
‘ | TO TOLPA | i I
MPC TRUNKING | ON [ m = [m] |
| | MODULE | ‘ I S -
| | YT T
| BTS I ____ CPBADRS _ GMODE,
| FREQ | RS232-GPIB
\ I MONITOR | INTERFACE BOX
| I SYNC l RS232 NULL
\ | MONITOR | MODEM
\ | LAN | CABLE
Lo == =
‘ | LﬁN |
| | 10BASET/ | CIPI\’/I\AFA
‘ 10BASE2
| L CONVERTER |
—— e -

——| INTERNAL PCMCIA
| UNIVERSAL TWISTED PAIR (UTP) ETHERNET CARD
\ CABLE (RJ45 CONNECTORS)

\
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Figure 3-12: TX Calibration Test Setup - Agilent E4406A and Advantest R3567
(IS-95A/B and CDMA2000 1X)

TEST SETS TRANSMIT (TX) SET UP

B rower] T power
SENSOR |

Agilent E4406A NOTE: IF BTS IS EQUIPPED (OFMT%EZ)* |
WITH DRDCS (DUPLEXED —
RX/TX SIGNALS), CONNECT l‘——————___l
THE TX TEST CABLE TO []:] COMMUNICATIONS |
; s = = THE DRDC ANTENNA TEST SET
[ [ . CONNECTOR.
] [ = oo |
(=] o9 I
&=l = l '
s =) 100-W ATT (MIN.) g'; 'INNFF’,LL’JTT%%% |
o NON-RADIATING
A RF LOAD —
@ ) GPIB I]—
Sl L !
O
= 00O ve=® O CABLE * APOWER METER CAN BE USED IN
PLACE OF THE COMMUNICATIONS

TEST SET FOR TX CALIBRATION/

= AUDIT

|
|
|
|
|
|
|
|
|
} TX TEST
|
|
|
|
|
|
|
|
|

’T‘ DIRECTIONAL
COUPLER
REPUT Temm [ o= ¢ (30 DB)
20 DB IN-LINE
ATTENUATOR
******************** { TX TEST
‘ CABLE
Advantest R3267 lr—r
I RX T
||| ANTENNA ANTENNA :
I CONNECTOR ~ CONNECTOR |
GPIB
1 TRDC | CABLE
} I RX RX ™ TX I
| [eTs  ANT BTS ANT ||
|| lcPLD CPLD CPLD CPLO|
T ] O | * BLACK RECTANGLES
| | REPRESENT THE RAISED
PART OF SWITCHES
} [ iNTERnAL |
> I
| : cABLE X aLe : ‘F DIP SWITCH SETTINGS - MODEj‘
DATA FORMAT
ﬂ 1 | BAUDRATE‘ ] ‘
: N TO TOLPA | | [
I MPC TRggEILNEG | | ON - mm (m |
M
INPUT 50 Q i I | T ‘ TT ‘ - | }
Il BTS | ‘L GPIB ADRS G MODE,
I FREQ | RszzioPE
1 MONITOR I INTERFACE BOX
H SYNC | RS232 NULL
1 MONITOR | MODEM
1 LAN | CABLE
‘ I B CSM I
=
LAN
} : . 10BASET/ ! 0L
‘ 10BASE2 I LMF
| L CONVERTER |
- 4
\ 1| INTERNAL PCMCIA
| UNIVERSAL TWISTED PAIR (UTP) ETHERNET CARD
CABLE (RJ45 CONNECTORS)
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Set-up for Optimization/ATP
Figure 3-13 and Figure 3-14 show the test set connections for
optimization/ATP tests.

Figure 3-13: 1S-95A/B Optimization/ATP Test Set-up, TRDC Shown - CyberTest and Advantest R3465

TEST SETS Optimization/ATP SET UP
T RF GEN OUT
Motorola CyberTest ‘ RX TEST ORRFOUTS0O F———————— 9
SYNCMONITOR  FREQ MONITOR | CABLE gOMMUN'CAT'ONS |
EVEN SEC TICK  19.6608 MHZ CLOCK | NOTE: IF 575 IS EQUIPPED VSTEM ANALYZER |
PULSE REFERENCE ~ REFERENCE FROM :
FROM CSM BOARD CSM BOARD WITH DRDCS (DUPLEXED | CDMA |
\ RX/TX SIGNALS), BOTH THE ITIMEBASE |
| TX AND RX TEST CABLES IN
CONNECT TO THE DRDC
| ANTENNA CONNECTOR. [ ¢ Sggg“m |
| (SEE FIGURE 3-15.) SYNC IN |
100-W ATT (MIN.) PY
M | NON-RADIATING || RF IN/OUT |
m | RF LOAD OR
ST iy INPUT 50 Q crial 1
1700-2000 MHz O | L_ I I |
TX TEST
I CABLE
RF GEN |
IN/OUT ouT %’
. . . | ‘ DIRECTIONAL
NOTE: The 30 dB directional coupler is not | 500 44 COUPLER
. 30 DB
used with the Cybertest test set. The TX | TERM (3008)
cable is connected directly to the Cybertest | .
A
testset. | !
| 20 DB IN-LINE
Advantest Model R3465 | ATTENUATOR
SYNC MONITOR EVEN
SEC TICK PULSE FREQ MONITOR | EX TEST
REFERENCE FROM 19.6608 MHZ CLOCK | i ABLE
CSM BOARD (F:lgFERgNCE FROM | r—L———— —
M BOARD
BNC | RX X
e L[| AnTERNA ANTENNA ||
E ‘ | | CONNECTOR CONNECTOR |
o
® * RF OUT 50Q GPIB
]:'l:r © © © ® : | TRDC | CABLE
= | | RX  RX ™  TX I
- | [8Ts  ANT BTS ANT ||
= GPIB CONNECTS | I CPLD CPLD CPLD CPLD I
o TO BACK OF UN'T| o O 0 * BLACK RECTANGLES
o s | | REPRESENT THE RAISED
[J°0oooo ) < | INPUT 50Q | I INTERNAL INTERNAL I PART OF SWITCHES
— Il RX X | [ DIP SWITCH SETTINGS - —— —
| CABLE CABLE S MODE
TO EXT TRIGGER CONNECTOR | | |
ON REAR OF TEST SET I | | BAUD RATE T FORMAT
(FOR DETAILS, SEE FIGURE F-3) | 10 TOLPA | OrYEL ] \
| MPC TRUNKING | ‘ ON - - [m |
| MODULE |
‘ - - - - ‘
! | o TTTTT T
| GPIB ADRS G MODE
-
I FREO | Rsz3zGPB
| | MONITOR T INTERFACE BOX
| I SYNC | RS232 NULL
| | MONITOR | MODEM
| LAN | CABLE
| B CSM
| : LAN 5 I
| | . 10BASET/ ! CDMA
| 10BASE2 I LMF
| CONVERTER |
e - - _
\ 1| INTERNAL PCMCIA
‘ UNIVERSAL TWISTED PAIR (UTP) ETHERNET CARD
CABLE (RJ45 CONNECTORS)
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Figure 3-14: 1S-95A/B Optimization/ATP Test Setup - HP 8921A
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Figure 3-15: 1S-95A/B and CDMA2000 1X Optimization/ATP Test Setup With DRDCs -
Agilent Test Equipment
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r—————————/"
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PERFORM 1X RX TESTING. |
| TX TEST
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Figure 3-16: 1S-95A/B and CDMA2000 1X Optimization/ATP Test Setup With DRDCs -
Advantest R3267/3562 Test Equipment
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Figure 3-17: 1IS-95A/B and CDMA2000 1X Optimization/ATP Test Setup With TRDCs -
Agilent Test Equipment

TEST SETS Optimization/ATP SET UP
' ‘T RX TEST RFOUTPUT50Q e —— — — — — — — 1
Agilent 8935 Model E6380A (formerly HP 8935) | CABLE OR DUPLEX Oui:] SIGNAL GENERATOR e
‘ IN
PATTERN (@mm—
SYNC MONITOR ~ FREQ MONITOR \ | TRIG IN g
EVEN SEC TICK  19.6608 MHZ CLOCK  HP-IB i AL
PULSE REFERENCE ~ REFERENCE FROM TO GPIB | I 1
FROM CSMBOARD  CSM BOARD BOX | RE INOUT COMMUNICATIONS
| OR RF INPUT 50 @ | SYSTEM ANALYZER 10 MHZ
1 out
S° ° oo | 100-W ATT (MIN.) ExT TRIGGER IN |
| . | | NON-RADIATING REF  EVEN SEC |
. ] | RF LOAD IN  SYNCHIN
0 ® O—E[ GPIB
H |
) = | T TESTL B A o
HEescoooe [ 1 | CABLE
_ 9 @ @ 406 C )
l ? | ’T‘ DIRECTIONAL
DUPLEX OUT 50 Q L COUPLER
RF IN/OUT | TERM </ (30 DB)
NOTE: | ' BNC
| ™
THE AGILENT 8935 WITH OPTION 200 OR R2K CAN PERFORM 1X |
TX ACCEPTANCE TESTING BUT NOT 1X RX ACCEPTANCE
TESTING. AN EXTERNAL SIGNAL GENERATOR MUST BE USED TO | 20 DB IN-LINE
PERFORM 1X RX TESTING. | ATTENUATOR
********************* - TX TEST
| CABLE
Agilent E4432B (Top) and E4406A (Bottom) | ——F% _____ -
H- RX T |
ANTENNA ANTENNA
I CONNECTOR CONNECTOR| | GPIB
[ ) CABLE
O Coad(e
[ — ol © ooag || TRDC I
= = SD Dg @ s || I
== OUTPUT
=S 0989 G soo || |Rx  Rx ™ 1 |
FSlozo 000 [| [BTS ANT BTS ANT ||
————————————=l@eeE 000 * || CPLD CPLD CPLD CPLDI
T T I I I I I
1 O | I
O[O0 Oja O I
=] =] [ | |
=0 ()
] e || | * BLACK RECTANGLES
i | =i | INTERNAL INTERNAL REPRESENT THE RAISED
=S oo e RS | PART OF SWITCHES
000 RFINPUT | CABLE CABLE
=} Do0o 50 Q | I
M®®000 0o || r DIP SWITCH SETTINGS - ~—
(]
g o0 s&= o © || To TOLPA I | DATA FORMAT | |
— ) ) | weC TRUNKING | | BAPRAE ]
TO TRIGGER IN gcrn\‘ ER)SAS%FF'N | MODULE | | ON| |m mm (= |
ON REAR OF TRANSMITTER | |
TRANSMITTER TESTER I BTS | - == - \
TO PATTERN TRIG IN TESTER || I | | GI‘:’IB‘AD‘RS‘ G Mc‘)DE\
ON REAR OF SIGNAL || | L. -/ T _J
GENERATOR I FREQ | RS232-GPIB
MONITOR T INTERFACE BOX
[]:I Il SYNC I
BNC I MONITOR i “RA%zDsé’\;I\JULL
s
Il LAN CsMm | CABLE
B
SYNC MONITOR e i ook | o
EVEN SEC TICK REFERENCE FROM || LAN |
PULSE REFERENCE A CDMA
CSM BOARD |
FROM CSM BOARD | 10BASET/
|| 10BASE2 | LMF
NOTE: ‘ CONVERTER i
—_— e
10 MHZ IN ON REAR OF SIGNAL GENERATOR IS CONNECTED TO |
1é>lé/|L|J4§EoFug (SWITCHED) ON REAR OF TRANSMITTER TESTER ‘ UNIVERSAL TWISTED
( -5). PAIR (UTP) CABLE INTERNAL PCMCIA
‘ (RJ45 CONNECTORS) ETHERNET CARD
Aug 2002 SC™4812ET Optimization/ATP Manual Software Release R16.1.x.x 3-63

PRELIMINARY

-l




-l

Calibration and Test Equipment

68P09255A57-2

Figure 3-18: 1S-95A/B and CDMA2000 1X Optimization/ATP Test Setup With TRDCs -

Advantest R3267/3562 Test Equipment
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TX ATP Setup
Figure 3-19 shows atypical TX ATP setup.
Figure 3-19: Typical TX ATP Setup with Directional Coupler (shown with and without RFDS)
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Figure 3-20: Typical RX ATP Setup with Directional Coupler (shown with or without RFDS)
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Loss/Gain Offset

Loss/Gain Offset

Background

Proper test equipment setup ensures that the test equipment and
associated test cables do not introduce measurement errors, and that
measurements are correct.

NOTE

If the test set being used to interface with the BTS has been
calibrated and maintained as a set, this procedure does not need
to be performed. (Test Set includes LMF terminal,
communications test set, additional test equipment, associated
test cables, and adapters.)

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated test cables and
adapters actually used to interface all test equipment and the BTS) has
been calibrated and maintained as a set.

CAUTION If any piece of test equipment, test cable, or RF adapter, that

makes up the calibrated test equipment set, has been replaced,
re-calibration must be performed. Failure to do so can introduce
measurement errors, resulting in incorrect measurements and
degradation to system performance.

NOTE

Calibration of the communications test set (or equivalent test
equipment) must be performed at the site before calibrating the
overall test set. Calibrate the test equipment after it has been
allowed to warm-up and stabilize for a minimum of 60 minutes.

Purpose

GPIB Addresses

Selecting Test Equipment

These procedures access the CDMA LMF automated calibration routine
used to determine the path losses of the supported communications
analyzer, power meter, associated test cables, and (if used) antenna
switch that make up the overall calibrated test set. After calibration, the
gain/loss offset values are stored in a test measurement offset file on the
CDMA LMF.

GPIB addresses can range from 1 through 30. The LMF will accept any
address in that range, but the numbers entered in the LMF Options
window GPIB address box must match the addresses of the test
equipment. Motorola recommends using 1 for a CDMA signal generator,
13 for a power meter, and 18 for a communications system analyzer. To
verify and, if necessary, change the GPIB addresses of the test
equipment, refer to the Setting GPIB Addresses section of Appendix F.

Use LMF Options from the Options menu list to select test equipment
automatically (using the autodetect feature) or manually.
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B
3
_

Prerequisites

A Serial Connection and a Network Connection tab are provided for
test equipment selection. The Serial Connection tab is used when the
test equipment items are connected directly to the CDOMA LMF
computer viaa GPIB box (normal setup). The Network Connection tab
is used when the test equipment is to be connected remotely viaa
network connection.

Ensure the following has been completed before selecting test
equipment:

¢ Test equipment is correctly connected and turned on.

¢ CDMA LMF computer serial port and test equipment are connected to
the GPIB box.

Manually Selecting Test Equipment in a Serial Connection Tab

Test equipment can be manually specified before, or after, the test
equipment is connected. CDMA LMF does not check to see if the test
equipment is actually detected for manual specification.

Table 3-30: Selecting Test Equipment Manually in a Serial Connection Tab

Step

Action

From the Tools menu, select Options.
The LMF Options window appears.

Click on the Serial Connection tab (if not in the forefront).

Select the correct serial port in the COMM Port pick list (normally COM 1).

Click on the Manual Specification button (if not enabled).

Click on the check box corresponding to the test item(s) to be used.

OO0~ WDN

Type the GPIB address in the corresponding GPIB address box (refer to the Setting GPIB Addresses
section of Appendix F for directions on verifying and/or changing test equipment GPIB addresses).
Motorola-recommended addresses are:

1 =signal generator

13 = power meter

18 = communications system analyzer

* IMPORTANT

When test equipment items are manually selected by the operator, the LMF defaults to using a power
meter for RF power measurements. The LMF will use a communications system analyzer for RF
power measurements only if a power meter is not selected (power meter checkbox not checked).

Click on Apply. (The button will darken until the selection has been committed.)

Click on Dismiss to close the test equipment window.
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Automatically Selecting Test Equipment in a Serial Connection Tab

When using the auto-detection feature to select test equipment, the
CDMA LMF examines which test equipment items are actually
communicating with CDOMA LMF. Follow the procedure in Table 3-31
to use the auto-detect feature.

Table 3-31: Selecting Test Equipment Using Auto-Detect

Step Action

1 From the Tools menu, select Options.
The LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM 1).

4 Click on Auto-Detection (if not enabled).

5 Typein the GPIB addresses in the box labeled GPIB addressto search (if not already displayed).
NOTE
Refer to the Setting GPIB addresses section of Appendix F for instructions on verifying or changing
test equipment GPIB addresses, if necessary.
When both a power meter and analyzer are selected, the first item listed in the GPIB addressesto
search box will be used for RF power measurements (i.e., TX calibration). The address for a signal
generator is normally 1, a power meter is normally 13 and the address for a CDMA analyzer is
normally 18. If 1, 13,18 are included in the GPIB addressesto search box, the power meter (13) will
be used for RF power measurements. If the test equipment items are manually selected the CDMA
analyzer is used only if a power meter is not selected.

6 Click Apply. The button will darken until the selection has been committed. A check mark will
appear in the Manual Configuration section for detected test equipment items.

7 Click Dismissto close the LMF Options window.

Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected, only the power
meter is zeroed.

Calibrate Test Equipment from the Util menu list is used to calibrate
test equipment item before being used for testing. The test equipment
must be selected before beginning calibration. Follow the procedurein
Table 3-32 to calibrate the test equipment.

Table 3-32: Test Equipment Calibration

Step

Action

From the Util menu, select Calibrate Test Equipment. A Directions window is displayed. Follow
the instructions provided.

Follow the direction provided.
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Table 3-32: Test Equipment Calibration

Step

Action

3 Click on Continue to close the Directions window. A status window is displayed.

4 Click on OK to close the status report window.

Calibrating Cables

The cable calibration function is used to measure the loss (in dB) for the
TX and RX cablesthat are to be used for testing. A CDMA analyzer is
used to measure the loss of each cable configuration (TX cable
configuration and RX cable configuration). The cable calibration
consists of the following procedures.

Measure the loss of a short cable. Thisis done to compensate for any
measurement error of the analyzer. The short cable, which is used only
for the calibration process, is used in series with both the TX and RX
cable configuration when they are measured. The measured |oss of the
short cable is deducted from the measured loss of the TX and RX
cable configuration to determine the actual loss of the TX and RX
cable configurations. This deduction is done so any error in the
analyzer measurement will be adjusted out of both the TX and RX
measurements.

Measure the short cable plus the RX cable configuration loss. The RX
cable configuration normally consists only of a coax cable with
type-N connectors that is long enough to reach from the BTS RX port
the test equipment.

Measure the short cable plus the TX cable configuration lossis
measured. The TX cable configuration normally consists of two coax
cables with type-N connectors and a directional coupler, aload, and
an additional attenuator if required by the BTS type. The total |oss of
the path loss of the TX cable configuration must be as required for the
BTS (normally 30 or 50 dB). The Motorola Cybertest analyzer is
different in that the required attenuation/load is built into the test set
so the TX cable configuration consists only of the required length
coax cable.

Calibrating Cables with a CDMA Analyzer

The Cable Calibration menu item from the Util menu list is used to
calibrate both TX and RX test cables for use with COMA LMF.

NOTE

LMF cable calibration cannot be accomplished with an
HP8921A anayzer for 1.9 MHz. A different analyzer type or the
signal generator and spectrum analyzer method must be used
(refer to Table 3-34 and Table 3-35). Cable calibration values
must be manually entered if the signal generator and spectrum
analyzer method is used. For the HP8921A, refer to Appendix F.

The test equipment must be selected before this procedure can be started.
Follow the procedure in Table 3-33 to calibrate the cables.
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Table 3-33:; Cable Calibration
Step Action

1 From the Util menu, select Cable Calibration. A Cable Calibration window is displayed.

2 Enter a channel number(s) in the Channels box. Multiple channels numbers must be separated with a
comma, no space (i.e., 200,800). When two or more channels numbers are entered, the cables will be
calibrated for each channel. Interpolation will be accomplished for other channels as required for TX
calibration.

3 Select TX and RX CABLE CAL, TX CABLE CAL or RX CABLE CAL inthe Cable Calibration
picklist.

4 Click OK. Follow the directions displayed for each step. A status report window will be displayed
with the results of the cable calibration.

Calibrating TX Cables Using a Signal Generator and Spectrum Analyzer

Follow the procedure in Table 3-34 to calibrate the TX cables using the
signal generator and spectrum analyzer. Refer to Figure 3-21 for a
diagram of the signal generator and spectrum analyzer.

Table 3-34: Calibrating TX Cables Using Signal Generator and Spectrum Analyzer
Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator.

2 Set signal generator to 0 dBm at the customer frequency of 869-894 MHz for 800 MHz CDMA and
1930-1990 MHz band for North American PCS.

3 Use spectrum analyzer to measure signal generator output (see Figure 3-21, “A”) and record the value.

4 Connect the spectrum analyzer’s short cable to point “B”, as shown in the lower portion of the
diagram, to measure cable output at customer frequency (869-894 MHz for 800 MHz CDMA and
1930-1990 MHz for North American PCS) and record the value at point “B”.

5 Calibration factor = A - B Example:  Cal = -1 dBm - (-53.5 dBm) = 52.5 dB

NOTE

The short cableis used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the equipment setup, asis, to ensure test procedures use
the correct calibration factor.
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Figure 3-21: Calibrating Test Equipment Setup for TX Cable Calibration
(Using Signal Generator and Spectrum Analyzer)
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Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer
Follow the procedure in Table 3-35 to calibrate the RX cables using the

signal generator and spectrum analyzer. Refer to Figure 3-22, if required.

Table 3-35: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

Step Action

1 Connect a short test cable to the spectrum analyzer and connect the other end to the Signal Generator.

2 Set signal generator to -10 dBm at the customer’s RX frequency of 824-840 MHz for 800 MHz
CDMA and 1850-1910 MHz band for North American PCS.

3 Use spectrum analyzer to measure signal generator output (see Figure 3-22, “A”) and record the value
for “A”.

4 Connect the test setup, as shown in the lower portion of the diagram, to measure the output at the
customer’s RX frequency in the 1850-1910 MHz band. Record the value at point **B”.

5 Cadlibration factor = A - B
Example: Ca =-12dBm - (-14 dBm) = 2 dB

NOTE

The short test cable is used for test equipment setup calibration only. It is not be part of the final test
setup. After calibration is completed, do not re-arrange any cables. Use the equipment setup, asis, to
ensure test procedures use the correct calibration factor.

Figure 3-22: Calibrating Test Equipment Setup for RX ATP Test
(Using Signal Generator and Spectrum Analyzer)
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Setting Cable Loss Values
Cable loss values for the TX and RX test cable configurations are
normally set by accomplishing cable calibration with use of the
applicable test equipment. The resulting values are stored in the cable
loss files. The cable loss values can also be set/changed manually.
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Prerequisites
* Logged into the BTS

Table 3-36: Setting Cable Loss Values

Step

Action

Click on the Util menu.

Select Edit >Cable Loss> TX or RX. A data entry pop-up window will appear.

w

Click on the Add Row button to add a new channel number. Then click in the Channel # and L oss
(dBm) columns and enter the desired values.

To edit existing values click in the data box to be changed and change the value.

To delete arow, click on the row and then click on the Delete Row button.

Click on the Save button to save displayed values.

N oo b~

Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
e |f cableloss values exist for two different channels the LMF will interpolate for al other channels.

¢ Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.

Setting Coupler Loss Value

If an in-service coupler isinstalled the coupler loss (e.g., 30 dB) must be
manually entered so it will be included in the LMF TX calibration and
audit calculations and the RX FER test.

Prerequisites
¢ Logged into the BTS

Table 3-37: Setting Coupler Loss Values

Step

Action

Click on the Util menu.

Select Edit >Coupler Loss>TX or RX. A data entry pop-up window will appear.

Click in the Loss (dBm) column for each carrier that has a coupler and enter the appropriate value.

To edit existing values click in the data box to be changed and change the value.

Click on the Save button to save displayed values.

Ol 0| B~ W NP

Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE

* Theln-Service Calibration check box in the Tools>Options>BTS Options tab must checked
before entered coupler loss values will be used by the TX calibration and audit functions or RX Fer
test.

¢ Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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Adjusting for loss

Introduction

Calibration compensates for normal equipment variations within the
BTS and assures maximum measurement accuracy.

RF Path Bay Level Offset Calibration

When to Calibrate BLOs

TX Path Calibration

Calibration identifies the accumulated gain in every transmit path (BBX
dlot) at the BTS site and stores that value in the CAL file. The BLOs are
subsequently downloaded to each BBX.

Each receive path starts at a BTS RX antenna port and terminates at a
backplane BBX dlot. Each transmit path starts at a BBX backplane slot,
travels through the LPA, and terminates at a BTS TX antenna port.

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in the CAL file. Each transmit
path starts at a C-CCP shelf backplane BBX dlot, travels through the
LPA, and ends at aBTS TX antenna port. When the TX path calibration
is performed, the RX path BLO will automatically be set to the default
value.

Calibration of BLOs is required after initial BTS installation.

The BLO data of an operational BTS site must be re-calibrated once
each year. Motorola recommends re-calibrating the BLO data for all
associated RF paths after replacing any of the following components or
associated interconnecting RF cabling:

* BBX board

e C-CCP shelf

e ClOcad

¢ CIO to LPA backplane RF cable

¢ LPA backplane

e LPA

o TX filter / TX filter combiner

¢ TX thru-port cable to the top of frame

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function

of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

WARNING Before installing any test equipment directly to any TX OUT

connector you must first verify that there are no CDMA
channels keyed. Have the OMC-R place the sector assigned to
the LPA under test OOS. Failure to do so can result in serious
personal injury and/or equipment damage.
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CAUTION Always wear a conductive, high impedance wrist strap while

handling any circuit card/module. If thisis not done, thereisa
high probability that the card/module could be damaged by ESD.

NOTE

At new site installations, to facilitate the complete test of each
CCP shelf (if the shelf is not already fully populated with BBX
boards), move BBX boards from shelves currently not under test
and install them into the empty BBX slots of the shelf currently
being tested to insure that all BBX TX paths are tested.

- This procedure can be bypassed on operational sitesthat are
due for periodic optimization.

- Prior to testing, view the CDF file to verify the correct
BBX dots are equipped. Edit the file as required to include
BBX dots not currently equipped (per Systems
Engineering documentation).

BLO Calibration Data File

During the calibration process, the LMF creates a calibration (BLO) data
file. After calibration has been completed, this offset data must be
downloaded to the BBXs using the Download BL O function. An
explanation of the file is shown below.

NOTE

Due to the size of the file, Motorola recommends that you print
out a hard copy of abts.cal file and refer to it for the following
descriptions.

The CAL fileis subdivided into sections organized on a per slot basis (a
slot Block).

Slot 1 contains the calibration data for the 12 BBX dots. Slot 20
contains the calibration data for the redundant BBX (see Table 3-39).
Each BBX dlot header block contains:

¢ A creation Date and Time - broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

* The number of calibration entries - fixed at 720 entries corresponding
to 360 calibration points of the CAL file including the slot header and
actual calibration data.

¢ The calibration datafor aBBX is organized as alargeflat array. The
array isorganized by branch, BBX dot, and calibration point.

- Thefirst breakdown of the array indicates which branch the
contained calibration points are for. The array covers transmit, main
receive and diversity receive offsets as follows:

Table 3-38: BLO BTS.cal file Array Branch Assignments

Range Assignment

C[1]-C[240] Transmit

C[241]-C[480] Receive

C[481]-C[720] Diversity Receive
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- The second breakdown of the array is per sector. Three sectors are

allowed.
Table 3-39: BTS.cal File Array (Per Sector)
BBX | Sectorization | TX | RX | RX Diversity
Slot[1] (Primary BBXs 1 through 12)

1 (Omni) 3-Sector, C[1]-C[20] C[241]-C[260] | C[481]-C[500]
2 1st C[21]-C[40] C[261]-C[280] | C[501]-C[520]
3 6 Sector, | Carrier | cr41)-c[60] C[281]-C[300] | C[521]-C[540]
4 C;lrsrti er | 3-Sector, C[61]-C[80] C[301]-C[320] | C[541]-C[560]
5 3rd C[81]-C[100] C[321]-C[340] | C[561]-C[580]
6 Carrier | c1101]-C[120] C[341]-C[360] | C[581]-C[600]
7 3-Sector, C[121]-C[140] C[361]-C[380] | C[601]-C[620]
8 2nd C[141]-C[160] C[381]-C[400] | C[621]-C[640]
9 6 Sector, | Carier | 1161]-C[180] C[401]-C[420] | C[641]-C[660]
10 Cgpr?er 3-Sector, C[181]-C[200] C[421]-C[440] | C[661]-C[680]
1 4th C[201]-C[220] C[441]-C[460] | C[681]-C[700]
12 Carrier | c1221]-C[240] C[461]-C[480] | C[701]-C[720]

Slot[20] (Redundant BBX-13)

1 (Omni) 3-Sector, C[1]-C[20] C[241]-C[260] | C[481]-C[500]
2 1st C[21]-C[40] C[261]-C[280] | C[501]-C[520]
3 6 Sector, | Carrier | c141)-c[60] C[281]-C[300] | C[521]-C[540]
4 C;lrsrti er | 3-Sector, C[61]-C[80] C[301]-C[320] | C[541]-C[560]
5 3rd C[81]-C[100] C[321]-C[340] | C[561]-C[580]
6 Carrier | c1101]-C[120] C[341]-C[360] | C[581]-C[600]
7 3-Sector, C[121]-C[140] C[361]-C[380] | C[601]-C[620]
8 2nd C[141]-C[160] C[381]-C[400] | C[621]-C[640]
9 6 Sector, | Carrier | c1161]-C[180] C[401]-C[420] | C[641]-C[660]
10 Cgpr?er 3-Sector, C[181]-C[200] C[421]-C[440] | C[661]-C[680]
1 4th C[201]-C[220] C[441]-C[460] | C[681]-C[700]
12 Carrier | c1221]-C[240] C[461]-C[480] | C[701]-C[720]

* Refer to the hard copy of the file. Asyou can see, 10 calibration
points per sector are supported for each branch. Two entries are
required for each calibration point.

* Thefirst value (all odd entries) refer to the CDMA channel
(frequency) the BLO is measured at. The second value (all even
entries) is the power set level. The valid range for PwrLvIAdj isfrom
2500 to 27500 (2500 corresponds to -125 dBm and 27500
corresponds to +125 dBm).

* The 20 calibration entries for each slot/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the largest frequency that is calibrated is
repeated to fill out the 10 points.
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Example:
C[1]=384, odd cal entry
= 1*“calibration point”
C[2]=19102, evencal entry
C[3]=777,
C[4]=19086,

C[19]=777,
C[20]=19086, (since only two cal points were calibrated this
would be repeated for the next 8 points)

¢ \When the BBX isloaded with BLO data, the cal file data for the BBX
is downloaded to the device in the order it is stored in the CAL file.
TxCal datais sent first, C[1] - C[60]. BBX dlot 1's 10 calibration
points are sent (C[1] - C[20]), followed by BBX slot 2's 10
calibration points (C[21] - C[40Q]), etc. The RxCal data is sent next,
followed by the RxDCal data.

* Temperature compensation datais also stored in the cal file for each
slot.

Test Equipment Setup: RF Path Calibration
Follow the stepsin Table 3-40 to set up test equipment.

Table 3-40: Test Equipment Setup (RF Path Calibration)

Step Action
NOTE
Verify the GPIB is properly connected and turned on.
I CAUTION

To prevent damage to the test equipment, all transmit (TX) test connections must be via the 30 dB
directional coupler for 800 MHz or viaa 30 dB coupler with a 20 dB in-line attenuator for 1900 MHz.

1 Connect the LMF computer terminal to the BTS LAN A connector on the BTS (if you have not
already done s0). Refer to the procedure in Table 3-6.

* If required, calibrate the test equipment per the procedure in Table 3-32.
¢ Connect the test equipment as shown in Figure 3-16, Figure 3-17 and Figure 3-18.

Transmit (TX) Path Calibration

The assigned channel frequency and power level (as measured at the top
of the frame) for transmit calibration is derived from the site CDF file.
For each BBX, the channel frequency is specified in the Channel Li st
CDF file parameter and the power is specified in the SI FPi | ot Pwr
CDF file parameter for the sector associated with the BBX (located
under the Par ent SECTOR field of the Par ent CARRI ER CDF file
parameter).

The calibration procedure attempts to adjust the power to within +0.5 dB
of the desired power. The calibration will passif the error isless than
+1.5 dB.

The TX Bay Level Offset at sites WITHOUT the directional coupler
option, is approximately 42.0 dB £3.0 dB.
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e At sitesWITHOUT RFDS option, BLO is approximately
42.0 dB +4.0 dB. A typical example would be TX output power
measured at BTS (36.0 dBm) minus the BBX TX output level
(approximately -6.0 dBm) would equate to 42 dB BLO.

The TX Bay Level Offset at sites WITH the directional coupler option,
is approximately 41.4 dB +£3.0 dB. TX BLO = Frame Power Output
minus BBX output level.

e Example: TX output power measured at RFDS TX coupler
(39.4 dBm) minus the BBX TX output level (approximately
-2.0 dBm) and RFDS directional coupler/cable (approximately
-0.6 dBm) would equate to 41.4 dB BLO.

The LMF Tests menu list items, TX Calibration and All Cal/Audit,
perform the TX BLO Calibration test for a XCVR(s). The All Cal/Audit
menu item performs TX calibration, downloads BLO, and performs TX
audit if the TX calibration passes. All measurements are made through
the appropriate TX output connector using the calibrated TX cable setup.

Test Pattern Drop-down Pick List

3

Pilot is shown as the default setting in this pick list box. The full range
of available selections and their descriptions are as follows:

Standard - performs calibration or audit using pilot, paging, synch, and
six traffic channels with 1S-97-specified gain. This pattern setting
should be used for all non-in-service calibrations and audits. Using this
pattern setting requires the selection of both aBBX and at |east one
MCC.

Pilot (default) - performs calibration using only the pilot channel. This
pattern setting should be used for in-service calibrations, and requires
selection of only a BBX.

CDFPilot -This pattern setting is for advanced users. It performs
calibration or audit using the CDF value for pilot gain and 1S-97 gain
values for all the other channels included in the Standard pattern setting
(paging, synch, and six traffic). Using this pattern setting requires the
selection of both aBBX and at least one MCC.

CDEF - This pattern setting is for advanced users who need to use CDF
gain settings for all channelsincluded in the Standard pattern setting
(pilot, paging, synch, and six traffic). Using this pattern setting requires
the selection of both aBBX and at least one MCC.

Verify BLO

In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO checkbox is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
additional items may be installed in the transmit path. The additional
change in gain from these items could cause BL O verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO checkbox should be unchecked or the additional path losses
should be added into each applicable sector using the

Util>Edit>T X Coupler L oss function.
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Single-Sided BLO

Normally valid values are some value plus-or-minus some offset. If
single-sided BLO” is selected, the result will only be considered a
successif it'sin the lower half of therange. If it was normally success
from 37-47 (which is 42+ 5), single-sided BLO” would make it a
success only if the result was from 37-42.

Prerequisites

Before running this test, ensure that the following have been done:

e CSM-1, GLIs, MCCs, and BBXs have correct code load and data
load.

* Primary CSM and MGLI are INS.
* All BBXsare OOS_RAM.

¢ Test equipment and test cables are calibrated and connected for TX
BLO calibration.

* LMF islogged into the BTS.

Connect the test equipment as shown in Figure 3-10 and Figure 3-11 and
follow the procedure in Table 3-41 to perform the TX calibration test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no COMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE Verify all BBX boards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX boards moved
since they were downloaded will have to be downloaded again.

Table 3-41: BTS TX Path Calibration

| Step Action
1 Select the BBX(s) to be calibrated.
NOTE
If STANDARD, CDF or CDFPILOT isselected for TEST PATTERN, then at least one MCC
must be also selected.
2 From the Tests menu, select TX>T X Calibration.
3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list. (Press and hold the
<Shift> or <Ctrl> key to select multiple items.)
4 Type the appropriate channel number in the Carrier n Channels box.
5 Select Verify BLO (default) or Single-sided BLO.
NOTE
Single-sided BL O is only used when checking non-redundant transceivers.
6 From the Test Pattern pick list, select atest pattern.
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Table 3-41: BTS TX Path Calibration

Action

NOTE

* Selecting PILOT (default) performs tests using a pilot signal only.

* Selecting STANDARD performs tests using pilot, synch, paging and six traffic channels. This
requires an MCC to be selected.

* Selecting CDFPilot performs tests using the CDF value for pilot gain and 1S-97 gain values for
all the other channels included in the Standard pattern setting (paging, synch, and six traffic).
Using this pattern setting requires the selection of both aBBX and at |east one MCC.

* Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the
gain for the channel elementsis specified in the CDF file.

7 Click on OK.

8 Follow the cable connection directions as they are displayed.
A status report window displays the test results.

9 Click on Save Results or Dismiss to close the status report window.

Download BLO Procedure

Exception Handling

In the event of afailure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re-run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.

After a successful TX path calibration, download the BLO calibration
file datato the BBXs. BLO datais extracted from the CAL filefor the
BTS and downloaded to the selected BBX devices.

NOTE

If asuccessful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

Prerequisites

Ensure the following prerequisites have been met before proceeding.
* BBXSs being downloaded are OOS-RAM (yellow).
e TX calibration is successfully completed.

Follow the stepsin Table 3-42 to download the BLO data to the BBXs.
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Table 3-42: Download BLO

Step

Action

1 Select the BBX(s) to be downloaded.

NOTE

2 From the Device menu, select Download>BL O.
A status report window displays the result of the download.

Selected device(s) do not change color when BLO is downloaded.

3 Click OK to close the status report window.

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibrations. The calibration audit procedure
measures the path gain or loss of every BBX transmit path at the site. In
thistest, actual system tolerances are used to determine the success or
failure of atest. The same external test equipment set up is used.

NOTE

RF path verification, BLO calibration, and BLO data download
to BBXs must have been successfully completed prior to
performing the calibration audit.

Transmit (TX) Path Audit

Perform the calibration audit of the TX paths of all equipped BBX dots,
per the stepsin Table 3-43.

WARNING Before installing any test equipment directly to any TX OUT

connector, first verify there are no COMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

NOTE

If asuccessful All Cal/Audit was completed, this procedure
does not need to be performed, as BLO is downloaded as part of
the All Cal/Audit.

TX Audit Test

The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running thistest, the following should be done:
e CSM-1,GLI3s, BBXs have correct code load.

* Primary CSM and MGL 13 are INS.

* All BBXsare OOS_RAM.
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¢ Test equipment and test cables are calibrated and connected for TX
BLO calibration.

* LMFislogged into the BTS.

Follow the procedure in Table 3-43 to perform the BTS TX Path Audit
test.

Table 3-43: BTS TX Path Audit

| Step Action
1 Select the BBX(s) to be audited.
NOTE
If STANDARD or CDF is selected for Test Pattern, then at least one MCC must be also selected.
2 From the Tests menu, select TX>T X Audit.
3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.
Press and hold the <Shift> or <Ctrl> key to select multiple items.
4 Type the appropriate channel number in the Carrier n Channels box.
5 Select Verify BLO (default) or Single-sided BLO.

NOTE

Single-sided BLO is only used when checking non-redundant transceivers.
6 From the Test Pattern pick list, select atest pattern.

NOTE

* Selecting PILOT (default) performs tests using a pilot signal only.

* Selecting STANDARD performs tests using pilot, synch, paging and six traffic channels. This
requires an MCC to be selected.

* Selecting CDFPILOT performs tests using the CDF value for pilot gain and 1S-97 gain values
for al the other channels included in the Standard pattern setting (paging, synch, and six
traffic). Using this pattern setting requires the selection of both aBBX and at |east one MCC.

* Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the
gain for the channel elementsis specified in the CDF file.

7 Click on OK.
8 Follow the cable connection directions as they are displayed.
A status report window displays the test results.
9 Click on Save Results or Dismiss to close the status report window.
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Exception Handling

In the event of afailure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re-run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.

3 All Cal/Audit Test
. The Tests menu item, All Cal/Audit, performs the TX BLO Calibration
and Audit test for a XCVR(s). All measurements are made through the

appropriate TX output connector using the calibrated TX cable setup.

NOTE If the TX calibration portion of the test passed, the BLO data
will automatically be downloaded to the BBX(s) before the audit
portion of the test is run.

Prerequisites

Before running this test, the following should be done:

e CSM-1, GLI3s, BBXs have correct code and data load.
Primary CSM and MGLI3 are INS.

All BBXsare OOS_RAM.

¢ Test equipment and test cables are calibrated and connected for TX
BLO calibration.

LMF islogged into the BTS.
Follow the procedures in Table 3-44 to perform the All Cal/Audit test.

WARNING Before installing any test equipment directly to any TX OUT
connector, first verify there are no COMA BBX channels
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.
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Table 3-44: All Cal/Audit Test

Action

Select the BBX(S) to be tested.

NOTE

If STANDARD, CDF or CDFPILOT is selected for TEST PATTERN, then at |east one MCC
must be also selected.

From the Tests menu, select All Cal/Audit.

Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.
Press and hold the <Shift> or <Ctrl> key to select multiple items.

Type the appropriate channel number in the Carrier n Channels box.

Select Verify BLO or Single-sided BLO.

NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

From the Test Pattern pick list, select atest pattern.
NOTE
* Selecting Pilot (default) performs tests using a pilot signal only.

* Selecting Standard performs tests using pilot, synch, paging and 6 traffic channels. This
requires an MCC to be selected.

* Selecting CDFPilot performs tests using the CDF value for pilot gain and 1S-97 gain values for
all the other channels included in the Standard pattern setting (paging, synch, and six traffic).
Using this pattern setting requires the selection of both aBBX and at |east one MCC.

* Selecting CDF performs tests using pilot, synch, paging and 6 traffic channels, however, the
gain for the channel elementsis specified in the CDF file.

Click on OK.

Follow the cable connection directions as they are displayed.
A status report window displays the test results.

Click on Save Results or Dismiss to close the status report window.

Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL filefor the BTS. If a CAL file does not exist a
new oneiscreated. If aCAL file aready existsit is updated. After a
BTS has been fully optimized a copy of the CAL file must exist so it can
be transferred to the CBSC. If TX calibration has been successfully
performed for all BBXs and BLO data has been downloaded, a CAL file
will exist. Note the following:

* The Create Cal File function only appliesto selected (highlighted)
BBXs.
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WARNING

Editing the CAL fileis not encouraged as this action can cause
interface problems between the BTS and the LMF. To manually
edit the CAL file you must first logout of the BTS. If you
manually edit the CAL file and then use the Create Cal File
function the edited information will be lost.

Prerequisites

Before running this test, the following should be done:
e LMFisloggedintothe BTS
* BBXsare OOS_RAM with BLO downloaded

Table 3-45: Create CAL File

Step

Action

1 Select the applicable BBXs. The CAL file will only be updated for the selected BBXs.

Click on the Device menu.

3 Click on the Create Cal File menu item.
The status report window is displays the results of the action.

4 Click OK.

RFDS Description

The optional RFDS is used to perform RF tests of the site from the
CBSC or from the LMF. The RFDS contains the following FRUS:

* Antenna Select Unit (ASU)
¢ Fixed Wireless Terminal Interface Card (FWTIC)
* Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA, and
the.LMF Help function on-line documentation.

RFDS Parameters

The bts-#.cdf file includes RFDS parameter settings that must match the
installed RFDS equipment. The paragraphs below describe the editable
parameters and their defaults. Table 3-46 explains how to edit the
parameter settings.

RfdsEquip - vaid inputs are O through 2.
0 = (default) RFDS is not equipped

1 = Non-Cobra/Patzer box RFDS

2 = Cobra RFDS

TsuEquip - valid inputsareO or 1

0 = (default) TSU not equipped

1=TSU isequipped in the system

MC1...4 - vaid inputsare 0 or 1

0 = (default) Not equipped

1 = Multicouplers equipped in RFDS system

(SC9600 internal RFDS only)
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* Asul/2Equip - valid inputsare O or 1
0 = (default) Not equipped
1 = Equipped

* TestOrigDN - valid inputs are "’ (default) or a numerical string up to
15 characters. (Thisis the phone number the RFDS dials when
originating acall. A dummy number needs to be set up by the switch,
and isto be used in thisfield.)

NOTE Any text editor may be used to open the bts-#.cdf fileto verify,
view, or modify data. Because the bts-#.cdf fileis generated on
a Unix system, a more sophisticated editor, such as MicroSoft
WordPad, will display file content in a more easily-read format
than many simple text editors.

Checking and Setting RFDS Parameters

Follow the procedure in Table 3-46 to review and/or edit RFDS
parameters.

Table 3-46: RFDS Parameter Settings

Step

Action

* IMPORTANT
Log out of the BTS prior to perform this procedure.

Using atext editor, verify the following fields are set correctly in the bts-#.cdf file:
EXAMPLE:

AsulEqui p
Asu2Equi p
Mc1Equi p
Mc2Equi p
Mc3Equi p
Mc4Equi p
Rf dsEquip = 2

Test Ori gDN = ' 123456789’
TsuEquip =1

1
0 (1 if system is non-duplexed)

0
0
0
0

NOTE

The above is an example of entries extracted from the bts-#.cdf file that should have been generated
by the OMC-R and copied to the LMF. These fields will have been set by the OMC-R if the
RFDSPARM database is modified for the RFDS.

2 Save changes and/or quit the editor.
3 Log into the BTS using an LMF GUI session(refer to Table 3-14).
4 If no changes were made to the bts-#.cdf filefieldslisted in step 1, proceed to Step 7. If changes were
made, continue with Step 5.
5 * IMPORTANT
To make certain the complete data download is accepted, the MGLI should be OOS_RAM (yellow)
when RFDS parameter settings are downl oaded.
When changes are made to RFDS parametersin the bts-#.cdf file, data must be downloaded to the
MGLI by performing the following:
.. . continued on next page
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Table 3-46: RFDS Parameter Settings

Step Action

5a - To be sure it does not take control when the MGLI is disabled, manually disable the redundant
GLI card by unseating it from the backplane connectors and dliding it partially out of the shelf
dot.

5b - Click on the MGLI.

5¢c - Click on Devicein the BTS menu bar, and select Disable from the pull-down menu.
-- A statusreport window is displayed showing status of the operation.

5d - When the operation is complete, click OK to close the status report window.

5e - Click onthe MGLI (now OOS_RAM (yellow)).

5f - Click on Devicein the BTS menu bar, and select Download > Data from the pull-down menus
(selected devices do not change color when data is downl oaded).
-- A statusreport window is displayed showing status of the download.

59 - Click OK to close the status report window.

5h - Click on the MGLI.

5i - Click on Devicein the BTS menu bar, and select Enable from the pull-down menu.
-- A statusreport window is displayed showing status of the operation.

5] - When the operation is complete, click OK to close the status report window.

I CAUTION

When the MGLI changesto INS_ACT, data will automatically be downloaded to the RFDS. During
this process, the RFDS LED will slowly begin flashing red and green for approximately 2-3 minutes.
DO NOT attempt to perform any functions with the RFDS until the LED remains steady green.

5k - Re-seat the redundant GLI card into the backplane connectors and lock it in place with the gector
tabs.
5l - Once the redundant GL 1 initializes, download datato it by selecting the card and, in the BTS
menu bar, clicking Device and selecting Download > Data from the pull-down menus.
6 Any MCCs which were INS_ACT when the MGLI was disabled must be disabled, re-enabled, and
downloaded with code as follows:
6a - Select the devices to be reset by clicking on them or using Select from the BTS menu bar and
clicking on MCCs in the pull-down menu.
6b - Inthe BTS menu bar, click on Device and select Disable from the pull-down menu.
-- A status window report window is displayed showing status of the operation.
6c - Click OK to close the status report window.
6d - Download data to the MCCs by following the procedure in Table 3-21.
6e - When data download is complete, enable the MCCs by following the procedure in Table 3-24.
7 Click on the RFDS tab.
8 Status the RFDS TSU by performing the following:
8a - Click on the SUA to select it.
.. . continued on next page
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Table 3-46: RFDS Parameter Settings

Step Action
8b - Click on TSU in the BTS menu bar, and select Status TSU from the pull-down menu.
-- A statusreport is displayed showing the software version number for the TSIC and SUA.
8c - Click OK to close the status report window.
* IMPORTANT

If the LMF displays an error message, check the following:

* Ensure AMR cable is correctly connected from the BTS to the RFDS.

Verify RFDS has power.

Verify RFDS status LED is green.

Verify entriesin RFDS fields of the bts-#.cdf file are correct (refer to step 1).

Status the MGL I and ensure it is communicating (by Ethernet) with the LMF, and isin the proper
state (INS_ACT (bright green)).

RFDS TSU NAM Programming

The Number Assignment Module (NAM) information needs to be
programmed into the TSU before it can receive and process test calls, or
be used for any type of RFDS test. The RFDS TSU NAM must be
programmed with the appropriate system parameters and phone number
during hardware installation. The TSU phone and TSU MSI must be
recorded for each BTS used for OMC-R RFDS software configuration.

NOTE The user will only need to program the NAM for theinitial
installation of the RFDS.

Explanation of Parameters Used When Programming the TSU NAM

Table 3-47 defines the parameters used when editing the tsu.nam file.

Table 3-47: Definition of Parameters

Access Overload Code These parameters are obtained from the switch.

Slot Index

System ID

Network 1D

Primary Channel A These parameters are the channels which are to be used in operation
Primary Channel B of the system.

Secondary Channel A
Secondary Channel B

Lock Code Do NOT change.
Security Code
Service Level
Station Class Mark

Aug 2002 SC™4812ET Optimization/ATP Manual Software Release R16.1.x.x 3-89
PRELIMINARY



B
3
_

Adjusting for loss

68P09255A57-2

Table 3-47: Definition of Parameters

IMSI MCC
IMSI 11 12

These fields are obtained at the OMC using the following command:
OMCO000>disp bts-# imsi

If the fields are blank, replace the IMSI fieldsin the NAM fileto 0,
otherwise use the values displayed by the OMC.

MIN Phone Number

These fields are the phone number assigned to the mobile. The ESN
and MIN must be entered into the switch as well.

NOTE

Thisfield is different from the TODN field in the bts-#.cdf file. The
MIN is the phone number of the RFDS subscriber, and the TODN is
the number the subscriber cals.

Valid NAM Ranges

Table 3-48 provides the valid NAM field ranges. If any of the fields are
missing or out-of-range, the RFDS will error out.

Table 3-48: Valid NAM Field Ranges

Valid Range
NAM Field Name Minimum Maximum

Access Overload Code 0 15
Slot Index 0 7
System ID 0 32767
Network 1D 0 32767
Primary Channel A 25 1175
Primary Channel B 25 1175
Secondary Channel A 25 1175
Secondary Channel B 25 1175
Lock Code 0 999
Security Code 0 999999
Service Level N/A N/A
Station Class Mark 0 255
IMSI 1112 0 99
IMSI MCC 0 999
MIN Phone Number N/A N/A

Set Antenna Map Data

The antenna map data must be entered manually if an RFDS isinstalled.
Antenna map data does not need to be entered if an RFDS is not
installed. The antenna map datais only used for RFDS tests and is
required if an RFDS is installed.

Prerequisite
¢ LMFislogged into the BTS

Follow the procedure in Table 3-49 to set antenna map data for the
RFDS.
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Table 3-49: Set Antenna Map Data

Step

Action

Click on Util in the BTS menu bar, and select Edit > Antenna Map... from the pull-down menus.
- A tabbed data entry pop-up window will appear.

2 In the data entry pop-up window, click on the TX Antenna Map or RX Antenna Map tab to select
the antenna map to be edited.

3 Locate the carrier and sector number for which data is to be entered or edited, and click in the column
where entry or editing is needed.

4 Enter/edit Antenna # and Antenna L abel column data as needed for each carrier.
NOTE
Refer to the CDM A Help > Utility Menu > Edit-Antenna Map... section of LMF Help function
on-line documentation for antenna map examples.

5 For each tab with changes, click on the Save button to save displayed values.

6 Click on the Dismiss button to close the window.

NOTE

* Values entered or changed after the Save button was used will be lost when the window is
dismissed.

¢ Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.

Set RFDS Configuration Data

If an RFDS isinstalled, the RFDS configuration data must be manually
entered.

Prerequisite
¢ LMFislogged into the BTS

NOTE The entered antenna# index numbers must correspond to the
antenna# index numbers used in the antenna maps.

Follow the procedure in Table 3-50 to set RFDS configuration data.

Table 3-50: Set RFDS Configuration Data

Step

Action

Click on Util in the BTS menu bar, and select Edit > RFDS Configuration... from the pull-down
menus.

- A tabbed data entry pop-up window will appear.

2 In the data entry pop-up window, click on the TX RFDS Configuration or RX RFDS Configuration
tab, as required.
3 To add a new antenna number, perform the following:
3a - Click on the Add Row button.
3b - Click in the Antenna #, Cal Antenna, Scap Antenna, or Populate [Y/N] columns, as required.
.. . continued on next page
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Table 3-50: Set RFDS Configuration Data

Step Action
3c - Enter the desired data.
4 To edit existing values click in the data box to be changed and change the value.

NOTE

Refer to the CDMA Help > Utility Menu > Edit-RFDS Configuration... section of LMF Help
function on-line documentation for RFDS configuration data examples.

5 To delete arow, click on the row and then click on the Delete Row button.
6 For each tab with changes, click on the Save button to save displayed values.
7 Click on the Dismiss button to close the window.

NOTE

* Values entered or changed after the Save button was used will be lost when the window is
dismissed.

¢ Entered values will be used by the LMF as soon as they are saved. It is not necessary to log out and
log back into the LMF for changes to take effect.

RFDS Calibration

The RFDS Calibration option is used to calibrate the RFDS TX and RX
paths.

TX Path Calibration - For aTX antenna path calibration the BTS
XCVR iskeyed at a pre-determined power level and the BTS power
output level is measured by the RFDS. The power level is then measured
at the TX antennadirectional coupler by the power measuring test
equipment item being used (power meter or analyzer). The difference
(offset) between the power level at the RFDS and the power level at the
TX antenna directional coupler is used asthe TX RFDS calibration
offset value.

RX Path Calibration - For an RX antenna path calibration the RFDS is
keyed at a pre-determined power level and the power input level is
measured by the BTS BBX. A CDMA signal at the same power level
measured by the BTS BBX isthen injected at the RX antenna directional
coupler by the communications system analyzer. The difference (offset)
between the RFDS-keyed power level and power level measured at the
BTSBBX isthe RFDS RX calibration offset value.

RFDS calibration and the CAL file - The TX and RX RFDS
calibration offset values are written to the CAL filein the slot[385]
Block.

TSIC channel frequency - For each RFDS TSIC, the channel
frequency is determined at the lower third and upper third of the
appropriate band using the frequencies listed in Table 3-51.

3-92

SC™4812ET Optimization/ATP Manual Software Release R16.1.x.x Aug 2002
PRELIMINARY




68P09255A57-2 Adjusting for loss

Table 3-51: RFDS TSIC Calibration Channel Frequencies
System Channel Calibration Paints
800 MHz (A and B) 341 and 682
19 GHz 408 and 791

WARNING Before installing any test equipment directly to any TX OUT
connector, verify that there are no CDMA channels keyed.
Failure to do so can result in serious personal injury and/or
equipment damage.

RFDS Calibration Procedure

Prerequisites
¢ Test equipment has been selected.
¢ Test equipment and test cables have been calibrated.

TX calibration has been performed and BL O data has been
downloaded to the BBXs.

¢ Test equipment and test cables are connected for TX calibration.
Antenna map data has been entered for the site.
BBXsare INS TEST.

Follow the procedure in Table 3-52 to perform RFDS calibration.
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Table 3-52: RFDS Cadlibration

Step Action
1 In the LMF, select the FRAME tab.
2 If it is not selected (no black dot showing), click on the B button in the BTS menu bar to select it.
3 Select the BBX(s) assigned to the carrier(s) and sector(s) which will be used in RFDS calibration

(refer to Table 1-5 for BBX carrier and sector assignments).

4 Click on RFDS in the BTS menu bar, and select RFDS Calibration... from the pull-down menu.
- AnRFDS Calibration set-up window will be displayed.
5 In the Teststo Perform box, select TX Calibration or RX Calibration, as required
6 Enter the appropriate channel number(s) (refer to Table 3-51) in the Channel Field box.
¢ To enter more than one channel number, use the following methods:
- Separate non-sequential channel numbers with a comma and no spaces,
for example: 247,585,742.
- Enter arange of sequential channels by typing the first and last channel numbersin the range
separated by a dash and no spaces,
for example: 385-395.
7 If the frame is equipped with TX combiners, click in the Has Combiner s checkbox.
8 Select the appropriate carrier(s) and sector(s) from the Carrierspick list (hold down the Shift or Ctrl
key while clicking on pick list items to select multiple carrier(s)-sector(s)).
9 Select the appropriate RX branch (Both, Main, or Diversity) in the drop-down list.
10 | Inthe Rate Set box, select the appropriate transfer rate (1=9600, 2=14400) from the drop-down list.
11 | Click onthe OK button.
- A statusreport window is displayed, followed by a Directions pop-up window.
12 | Follow the cable connection directions as they are displayed.
13 | When the test is completed, test results are displayed in the status report window.
14 | Click onthe OK button to close the status report window.
15 | Click on the Frame tab.
16 | Select the MGLI by clicking on it.
17 | Download the CAL file, now updated with the RFDS offset data, to the MGLI by clicking on Device

on the BTS menu bar, and selecting Download > Data from the pull-down menus.

NOTE
The MGLI will automatically transfer the RFDS offset data from the CAL file to the RFDS.

Program TSU NAM

The NAM must be programmed before it can receive and process test
calls, or be used for any type of RFDS test.

Prerequisites

* MGLI iSINS _ACT (bright green).

* SUA ispowered up and has a code |oad.

Follow the procedure in Table 3-53 to program the TSU NAM.
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Table 3-53: Program NAM Procedure

Step Action
1 In the LMF, select the RFDS tab.
2 Select the SUA by clicking on it.
3 Click on TSU in the BTS menu bar, and select Program TSU NAM from the pull-down menu.
- A NAM programming window will appear.
4 Enter the appropriate information in the boxes (see Table 3-47 and Table 3-48) .
5 Click on the OK button to display the status report.
6 Click on the OK button to close the status report window.
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Alarms

Alarm Reporting Display

Heat Exchanger Alarm Test

The alarms testing should be performed at a convenient point in the
optimization/ATP process, since the LMF is necessary to ensure that the
RF cabinet is receiving the appropriate alarms from the power cabinet.

The SC 4812ET is capable of concurrently monitoring 10 customer
defined input signals and four customer defined outputs, which interface
to the 50-pin punchblock. All alarms are defaulted to “Not Equipped”
during ATP testing. Testing of these inputs is achieved by triggering the
alarms and monitoring the LMF for state-transition messages from the
active MGLI3.

All customer alarms are routed through the 50 pair punchblock located
in the I/O compartment at the back of the frame. Testing is best
accomplished by using a specialized connector that interfaces to the
50-pair punchblock. This connector is wired so that customer return 1 (2
for the B side) is connected to every input, CDI 0 through CDI 17.

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included:

¢ The Options button allows for a severity level (Warning, Minor,
Major, Critical, and Unknown) selection. The default is all levels.
To change the level of alarms reported click on the Options button
and highlight the desired alarm level(s). To select multiple levels press
the Ctrl key (for individual selections) or Shift key (for arange of
selections) while clicking on the desired levels.

* The Pause button can be used to pause/stop the display of alarms.
When the Pause button is clicked the name of the button changes to
Continue. When the Continue button is click the display of alarms
will continue. Alarms that occur between the time the Pause button is
clicked and the Continue button is clicked will not be displayed.

¢ The Clear button can be used to clear the Alarm Monitor display.
New alarms that occur after the Clear button is clicked will be
displayed.

e The Dismiss button is used to dismiss/close the Alarm Monitor
display.

Table 3-54 gives instructions on testing the Heat Exchanger alarm.
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Table 3-54: Heat Exchanger Alarm
Step Action

1 Turn circuit breaker “B” of the Heat Exchanger circuit breakers OFF. Thiswill generate a Heat
Exchanger alarm, ensure that the LMF reports the correct alarm condition in the RF Cabinet.

2 Alarm condition will be reported as BTS Relay #25 - “Heat Exchanger Alarm” makes contact.

3 Turn the circuit breaker “B” ON. Ensure that the alarm condition is now removed.

NOTE
The Heat Exchanger will go through the Start Up sequence.

Door Alarm
Table 3-55 gives instructions on testing the door alarms.
NOTE When conducting this test connect the LMF viathe LAN port on
the back of the frame thru the Rear 1/0O Door.
Table 3-55: Door Alarm
Step Action

1 Close all doors on the power cabinet. Ensure that no alarms are reported on the LMF.

2 Individually open and then close each power supply cabinet door. Ensure that the LMF reports an
alarm when each door is opened.

3 Alarm condition will be reported as BT S Relay #27 “Door Alarm” makes contact.

AC Fail Alarm
Table 3-56 gives instructions on testing the AC Fail Alarm.
Table 3-56: AC Fail Alarm
Step Action
1 NOTE

The batteries should have a stable charge before performing this test.

Turn the Main AC breaker on the power cabinet OFF. The LMF should report an alarm on an AC Fail
(Rectifier Fail, Minor Alarm & Mgjor Alarm) condition.

2 Alarm condition will be reported as BTS Relay #23, BTS# 21, BTS# 24 and BTS Relay #29“AC
Fail Alarm” makes contact respectively.

3 Turn the Main AC breaker on the power cabinet ON. The AC Fail alarm should clear.

Minor Alarm

Table 3-57 gives instructions on testing minor alarm.
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Table 3-57: Minor Alarm
Step Action

1 Turn the Temperature Compensation Panel (TCP) power switch OFF. Thiswill generate a minor
alarm. Verify that the minor alarm LED (amber) isilluminated on the Meter Alarm Panel and the
LMF reports this minor alarm.

2 Alarm condition will be reported as BTS Relay #24 “Minor Alarm” makes contact.

3 Turn the TCP power switch ON. The alarm condition should clear.

Rectifier Alarms

The following series of tests are for single rectifier modules in amultiple
rectifier system. The systemsinclude athree rectifier and asix rectifier
system.

Single Rectifier Failure (Three Rectifier System)

Table 3-58 gives instructions on testing single rectifier failure or minor
aarmin athreerectifier system.

Table 3-58: Single Rectifier Fail or Minor Alarm
Step Action

1 Remove a single rectifier module and place it into the unused rectifier shelf #2.
2 Turn the AC breaker OFF, for this 2nd shelf.

3 Verify that arectifier fail dlarm is generated. The single rectifier module will lite two RED fail LED
(DC and Power), and the Meter Alarm Panel and LMF will also indicate a minor alarm and rectifier
fall status. The RECTIFIER FAIL LED will lite.

4 Check that the LMF reports both of these alarm conditions.

NOTE
Alarm conditions reported as BT S #24 and BT S #21, contacts respectively.

5 Turn the AC breaker for the 2nd shelf ON and verify that Rectifier Fail and minor alarm conditions
clear on the Meter Alarm Panel and LMF.

Multiple Rectifier Failure

Table 3-59 gives instructions on testing multiple rectifier failure or major
aarmin athreerectifier system.

Table 3-59: Multiple Rectifier Failure or Maor Alarm

Step Action

1 With the rectifier module still in the unused shelf position fromTable 3-58 test procedures, turn the
AC breaker for the 1st shelf OFF.

2 Verify that arectifier alarm is generated. Each of the two rectifier modules will lite two RED fail LED
(DC and Power), and the Meter Alarm Panel and LMF will indicate amajor alarm (Rectifier Fail and
Major Alarm). The RECTIFIER FAIL LED will lite.

.. . continued on next page
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Table 3-59: Multiple Rectifier Failure or Magjor Alarm

Step Action

3 Verify that the LMF reports both alarm conditions. (BT S #29, BTS #21, and BT S #24)
4 Turn the AC breaker for the 1st shelf ON. Verify that al alarms have cleared.

5 Return the rectifier module to its original location. This completes the alarm test on the power cabinet.

Single Rectifier Failure
(Six Rectifier System)

Table 3-60 gives instructions on testing single rectifier failure or minor
alarmin asix rectifier system.

Table 3-60: Single Rectifier Fail or Minor Alarm

Step Action

1 Remove two(2) rectifier modules from shelf #2.
2 Turn the AC breaker OFF, for shelf #2.

3 Verify that arectifier fail dlarm is generated. The single rectifier module will lite two RED fail LED
(DC and Power), and the Meter Alarm Panel and LMF will also indicate a minor alarm and rectifier
fall status. The RECTIFIER FAIL LED will lite.

Check that the LMF reports both of these alarm conditions. (BTS #24 and BT S #21)

Turn the AC breaker for this shelf ON and verify that Rectifier Fail and Minor Alarm conditions have
Cleared.

Multiple Rectifier Failure (Six Rectifier System)

Table 3-61 gives instructions on testing multiple rectifier failure or
major dlarm in asix rectifier system.

Table 3-61: Multiple Rectifier Failure or Maor Alarm

Step Action

1 Replace one rectifier module previously removed and turn the AC breaker for this shelf, OFF.

2 Verify that arectifier alarm is generated. Each of the two rectifier modules will lite a RED fail LED,
and the Meter Alarm Panel will indicate amajor alarm (Rectifier Fail, Major and Minor Alarm).The
RECTIFIER FAIL LED will lite.

3 Verify that the LMF reports both alarm conditions. (BT S #29)
4 Turn the AC breaker for this shelf ON. Verify that al alarms have cleared.

5 Return all rectifier module to their original location. This completes the rectifier alarm tests on the
power cabinet.
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Battery Over Temperature Alarm (Optional)

CAUTION Use special care to avoid damaging insulation on cables, or
damaging battery cases when using a power heat gun.

Table 3-62 gives instructions on testing the battery over temperature
alarm system.

Table 3-62: Battery Over Temperature Alarm

Step Action
1 Use alow powered heat gun and gently heat the battery over temperature sensor (see location in
Figure 3-23). Do Not hold the hot air gun closer than 7.6 cm (3 in.) to the sensor. Thiswill avoid
burning the cable insulation.
2 When the sensor is heated to approximately 50° C, a battery Over Temperature alarm is generated.

NOTE
An audible click will sound as K1 contact engage and K2 contacts disengage.

3 Visually inspect the K1 and K2 relays to verify state changes. The LMF should be displaying correct
alarms. (BTS #22)
4 Verify that the CHARGE DISABLE LED (amber) on the Meter Alarm Panel and the BATTERY
MAIN LED (green) are both illuminated.
5 Switch the hot air gun to cool. Cool the sensor until the K1 and K2 contact return to normal position
(K1 open and K2 closed). Usethe LMF verify that all alarms have cleared.
3-100 SC™4812ET Optimization/ATP Manual Software Release R16.1.x.x Aug 2002

PRELIMINARY




68P09255A57-2 Alarms

Figure 3-23: Battery Over-temperature Sensor
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Rectifier Over Temperature Alarm

NOTE Thisis connector J8 on the rear of the Meter Alarm Panel itself,
thisis not connector J8 on the connector bulkhead at the rear of
the cabinet.

Table 3-63 gives instructions on testing the battery over temperature
alarm system.

Table 3-63: Rectifier Over Temperature Alarm

Step Action

1 Remove the J8 link on the rear of the Meter Alarm Panel (see Figure 3-24 for J8 location).
NOTE
Thisisthe J8 on the rear of the Meter Alarm Panel itsdlf, thisis not connector J8 on the connector
bulkhead at the rear of the cabinet.

2 Verify that RECTIFIER OVERTEMP LED (red) islite. Contacts on K1 and K2 change states (K1
now closed and K2 open).

3 Verify that the LMF has reported an alarm condition. (BT S #26)

4 Reinstall J8 connector and verify that all alarm conditions have cleared. K1 and K2 should now bein
their normal states (K1 open and K2 closed).

5 This completes the system tests of the SC 4812ET power cabinet.

Figure 3-24: Location of Connector J8 on the Meter Alarm Panel
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Before Leaving the site

Table 3-64 gives instructions on what to check before leaving the site.

Table 3-64: Check Before Leaving the Site
Step Action
Verify that ALL battery circuit breakers (for occupied shelves) are CLOSED (pushed in).

Verify that the Heat Exchanger is running.

Verify that the Meter Alarm Panel and TCP modules are switched ON.
Verify that the Battery Test Switch on the Meter Alarm Panel is in the OFF position.

g b~ W NP

-l

Verify that no alarm conditions are being reported (with all doors closed).
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Notes
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ATP Tests

Introduction

Reduced ATP

The Automated Acceptance Test Procedure (ATP) alows Motorola
Cellular Field Engineers (CFES) to run automated acceptance tests on al
equipped BTS subsystem devices using the Local Maintenance Facility
(LMF) and supported test equipment per the current Cell Site Data File
(CDF) assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled viathe LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CL1) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands.

NOTE

Before using the LMF, use an editor to view the "CAVEATS’
section in the "readme.txt” filein the c:\wlmf folder for any
applicable information.

The ATP test is to be performed on out-of-service sectors only.

DO NOT substitute test equipment with other models not
supported by the LMF.

NOTE

Equipment has been factory-tested for FCC compliance. If
license-governing bodies require documentation supporting
SITE compliance with regulations, afull ATP may be necessary.
Perform the Reduced ATP only if reports for the specific BTS
siteare NOT required.

After downloading the proper operational software to the BTS, the
Cellular Field Engineer (CFE) must perform these procedures (minimal
recommendation):

1 Verify the TX/RX paths by performing TX Calibration, TX Audit
and FER tests.

2 Retrieve Calibration Data required for normal site operation.

Should failures occur while performing the specified tests, refer to the
Basic Troubleshooting section of this manual for help in determining the
failure point. Once the point of failure has been identified and corrected,
refer to the BTS Optimization and ATP Test Matrix section (Table B-1)
to determine the applicable test that must be performed.
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In the unlikely event that the BTS passes these tests but has a forward
link problem during normal operation, the CFE should then perform the
additional TX tests for troubleshooting: TX spectral mask, TX rho, and
TX code domain.

NOTE

Refer to Chapter 3 for detailed information on test set
connections for calibrating equipment, cables and other test set
components, if required.

| ATP Test Prerequisites

Customer requirements determine which ATP tests are to be performed
and the field engineer selects the appropriate ATP tests to run.

The tests can be run individually or as one of the following groups:

e All TX: TX tests verify the performance of the BTS transmit line up.
These include the GLI13, MCC, BBX, and CIO cards, the LPAs and
passive components including splitters, combiners, bandpass filter,
and RF cables.

* All RX: RX tests verify the performance of the BTS receiver line up.
These includes the MPC (for starter frames), EMPC (for expansion
frames), Cl1O, BBX, MCC, and GL 13 cards and the passive
components including RX filter (starter frame only), and RF cables.

e All TX/RX: Executes dl the TX and RX tests.

¢ Full Optimization: Executesthe TX calibration, download BLO, and
TX audit before running al of the TX and RX tests.

Before attempting to run any ATP tests, ensure the following:
¢ BTS has been optimized and calibrated (see Chapter 3).
* LMFislogged into the BTS.

* CSMs, GLI3s, BBXs, MCCs and TSU (if the RFDS is installed)have
correct code load and data load

* Primary CSM and GLI3 are INS_ACT

* MCCsare INS_ACT.

* BBXsare OOS-RAM.

¢ BBXsare calibrated and BL Os are downl oaded.

¢ Test cables are calibrated.

¢ Test equipment is selected.

¢ Test equipment is connected for ATP tests.

¢ Test equipment has been warmed up 60 minutes and calibrated.
e GPIB ison.

WARNING Before the FER isrun, be sure that all LPAs are turned OFF

(circuit breakers pulled) or that all transmitter ports are properly
terminated.

All transmit ports must be properly terminated for all ATP tests.

Failure to observe these warnings may result in bodily injury or
equipment damage.

Aug 2002 SC™4812ET Optimization/ATP Manual Software Release R16.1.x.x 4-3

PRELIMINARY




-

ATP Tests 68P09255A57-2

TX/RX OUT Connections

NOTE Table:note. Note 10pt Helvetica
Many of the acceptance test procedures require taking
measurements at the TX OUT (BTS/RFDS) connector. At sites
with RFDS, all measurements are through the RFDS directional
coupler TX OUT connector.

ATP Test Procedure

There are three different ATP testing options that can be performed to
completely test aBTS. Depending on your requirements, one of the
following ATP testing options should be run. Table 4-1 provides the
procedure to execute an ATP test. To completely test aBTS, run the ATP
tests according to one of the following ATP testing options.

ATP Testing Option 1
e All TX/RX test

ATP Testing Option 2
e All TX test
e All RX test

ATP Testing Option 3

e TX Mask test

Rho test

Pilot Time Offset test
Code Domain Power test
FER test

NOTE The Full Optimization test can be run if you want the TX path
calibrated before al the TX and RX tests are run.

NOTE If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the card
slot and set the IO CONFIG to the Talk & Listen mode before
starting the automated testing.

CDMA 2000 Testing

Software release 2.16.x supports two new pieces of test equipment.
These are the Agilent E4406A with E4432B, as well as the Advantest
R3267 with R3562. The E4406A/E4432B pair, or the R3267/R3562
pair, should be connected together using a GPIB cable. This test
equipment is capable of performing tests in both 1S95 mode as well as
cdma2000 mode if the required options are installed:

The HP 8935 with option 200 or R2k for 1X TX and with Agilent
E4432B Signal Generator for 1X FER (see note for options).

NOTE E4432B Signal Generator” for 1X FER. The options are:
UNB8-Real Time I/Q Baseband Generator
1E5-High Stability Timebase
201-Real Time CDMA2000

4-4 SC™4812ET Optimization/ATP Manual Software Release R16.1.x.x Aug 2002
PRELIMINARY



68P09255A57-2

ATP Tests

Individual Acceptance Tests

The following individual ATP tests can be used to verify the results of
specific tests:

Spectral Purity TX Mask

This test verifies that the transmitted CDMA carrier waveform,
generated on each sector, meets the transmit spectral mask specification
with respect to the assigned CDF file values.

Waveform Quality (rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified valuein
ANSI-J_STD-019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

4
H

Code Domain Power

This test verifies code domain power levels, which have been set for al
ODD numbered Walsh channels, using the OCNS command. Thisis
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of al EVEN numbered “ OFF”
Walsh channels measures < -27 dB .

Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sector/antennas. The test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of -119 dBm (or -116 dBm if using TMPC). Follow
the procedure in Table 4-1 to perform any ATP test.

NOTE

The ST OP button can be used to stop the testing process.
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ATP Test Procedure

Table 4-1 describes the step-by-step procedures to run any APT Test.

Table 4-1; ATP Test Procedure

Step Action

1 Select the device(s) to be tested.

2 From the Tests menu, select the desired test.

3 Select the appropriate carrier(s) (carrier - bts# - sector# - carrier#) displayed in the Channels/Carrier
pick list.
To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

4 Type the appropriate channel number in the Carrier n Channels box.
The default channel number displayed is determined by the CdmaChang[n] number in the cbsc-n.cdf
filefor the BTS.

5 If applicable, select Verify BLO (default) or Single-sided BLO.
NOTE
Single-sided BLO is only used when checking non-redundant transceivers.

6 For RX select the appropriate RX branch (Both, Main, or Diversity) in the drop-down list.

7 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop-down list.
NOTE
The Rate Set selection of 3isonly available if 1X cards are selected for the test.

8 In the Test Pattern box, select the test pattern to use for the calibration from the drop-down list: Pilot
(default), CDF, CDFPilot or Standard.

9 Click OK.
The status report window and a Directions pop-up are displayed.

10 | Follow the cable connection directions as they are displayed.

11 | Click Save Results or Dismiss to close the status report window.

If Dismissis used the test results will not be saved in the test report file.

Background: Tx Mask Test

This test verifies the spectral purity of each BBX2 carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are through the appropriate TX OUT
(BTS/RFDS) connector.

The Pilot Gain is set to 541 for each antenna and all channel elements
from the MCCs are forward-link disabled. The BBX2 is keyed up, using
both bbxIvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX2 power output is set to obtain +40 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler).
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NOTE TX output power is set to +40 dBm by setting BTS power level
to +33.5 dBm to compensate for 6.5 dB increase from pilot gain
set to 541.

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM productsin a 30 kHz resolution
bandwidth with respect to the mean power of the CDMA channel,
measured in a 1.23 MHz bandwidth, in dB, verifying that results meet
system tolerances at the following test points:

* 19GHz
- atleast-45 dB @ + 885 kHz from center frequency
- atleast-45 dB @ - 885 kHz from center frequency
e 800 MHz:
- atleast-55dB @ + 750 kHz from center frequency
- atleast-55 dB @ - 750 kHz from center frequency
- atleast-60 dB @ + 1980 kHz from center frequency
- atleast-60 dB @ - 1980 kHz from center frequency

The BBX2 then de-keys, and, if selected, the MCC is re-configured to
assign the applicable redundant BBX2 to the current TX antenna path
under test. The test is then repested.

Figure4-1: TX Mask Verification Spectrum Analyzer Display

.5 MHz Span/Div Mean CDMA Bandwidth
Ampl 10 dB/Div ‘ Power Reference ‘

____ Center Frequency
Reference

Attenuation level of all

L S N ~__ spurious and IM products
‘ with respect to the mean
WMAWWF WWWF power of the CDMA channel
\ \
\ \
\ \
- 1980 kHz + 1980 kHz
- 900 kHz +900 kHz
- 750 kHz +750 kHz FW00282
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Background: Rho Test

This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX2 carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are viathe appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all channel el ements
from the MCCs will be forward link disabled. The BBX2 is keyed up
using both bbxIvl and bay level offsets, to generate a CDMA carrier
(with pilot channel element only, Walsh code 0). BBX2 power output is
et to 40 dBm as measured at the TX OUT connector (on either the BTS
or RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that
result meets system tolerances. Waveform quality (rho) should be

>0.912 (-0.4 dB).
The BBX2 then de-keys and the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.

The LMF Tests menu list item, Rho, performs the waveform quality test
for aXCVR(s). All measurements are made through the appropriate TX
output connector using the calibrated TX cable setup.

Background: Pilot Offset Acceptance Test

This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX2 carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
will be viathe appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gainis set to 262 for each antenna and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up using both
bbxlvl and bay level offsets to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to

40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in uS, verifying results meet system tolerances. Pilot Time
Offset should be within < 3 ps of the target PT Offset (0 uS).

The BBX2 then de-keys, and the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.
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Background: Code Domain Power Test

This test verifies the Code Domain Power/Noise of each BBX2 carrier
keyed up at a specific frequency per the current CDF file assignment.

All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

For each sector/antenna under test, the Pilot Gain is set to 262 and all
MCC channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes, and are
assigned a full-rate gain of 81. The maximum number of MCC/CEs to
be tested at any onetimeis 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made, so all channel
elements are verified on all sectors.

BBX2 power output is set to 40 dBm as measured at the TX OUT
connector (on either the BTS or RFDS directional coupler).

Code domain power levels, which have been set for al ODD numbered
Walsh channels, are verified using the OCNS command. Thisis done by
verifying that Pilot Power (dBm) minus OCNS Power (dBm) is equal to
10.2 + 2 dB and that the noise floor of all “OFF" Walsh channels
measures < -27 dB (with respect to total CDMA channel power).

The BBX2 then de-keys and, the applicable redundant BBX2 is assigned
to the current TX antenna path under test. The test is then repeated.
Upon completion of the test, OCNS is disabled on the specified
MCCICE.
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Figure 4-2: Code Domain Power and Noise Floor Levels
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Background: FER Test

This test verifiesthe BTS FER on all traffic channel elements currently
configured on all equipped MCCs (full rate at 1% FER) at an RF input
level of -119 dBm [or -116 dBm if using Tower Top Amplifier
(TMPC)]. All tests are performed using the external calibrated test set as
the signal source controlled by the same command. All measurements
will beviathe LMF.

The pilot gainis set to 262 for each TX antennaand all channel elements
from the MCCs are forward-link disabled. The BBX2 is keyed up using
only bbxlvl level offsets, to generate a CDMA carrier (with pilot channel
element only). BBX2 power output is set to -20 dBm as measured at the
TX OUT connector (on either the BTS or RFDS directional coupler).
The BBX2 must be keyed in order to enable the RX receive circuitry.
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